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Jana-gana-mana adhinayaka jaya he
Bharatha-bhagya-vidhata,

Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga

Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga

Tava subha name jage,
Tava subha asisa mage,
Gahe tava jaya gatha.

Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata,
Jaya he, jaya he, jaya he,

Jaya jaya jaya jaya he!
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India is my country. All Indians are my
brothers and sisters.
I love my country, and I am proud of its rich
and varied heritage. I shall always strive to
be worthy of it.
I shall give my parents, teachers and all elders
respect, and treat everyone with courtesy.
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devotion. In their well-being and prosperity
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FOREWORD

Dear Learners,

The world around us is changing fast. The borderlines that
were created by time and distance are fading away. The infinite
potentials of Information and Communication Technology  made
so many things possible which were considered impossible. This
is the era in which our classrooms are rapidly transforming into
smart rooms with multimedia facilities, as a result of new
technology.  In tune with these changes, the contents in this textbook
are developed to enable you to move towards the world of
technology, to promote self-study and to construct new knowledge.

Each and every activity included in this textbook is prepared
by assimilating the contexts in similar lessons from other
subjects. It will be helpful for the study of those lessons.

The lessons are designed in such a way that practical work
is given prime emphasis. I sincerely believe that you will be
able to do and practise all learning activities given in this
textbook, and make use of those acquired skills in the study of
other subjects as well.

Dr. P. A. Fathima
Director
SCERT

FOREWORD
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Certain icons are used in this
textbook for convenience

For further reading
(Evaluation not required)

Let’s Evaluate

Follow up activities
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7Information & Communication Technology - VIII

When A Letter Reaches the Computer

By learning this unit, the learner will be
able to:
 identify and use different text input-output

devices.

 acquire speed and accuracy in typing using
keyboard.

 use efficiently the text editing tools like cut, copy,
paste, etc.

 organise the text into different paragraphs.

 insert pictures in  text at relevant positions.

The Recuyell of the Historyes of Troye

William Caxton was the first Englishman who learned
to use a printing press. The Recuyell of the Historyes of
Troye was the first book he printed and the first book
printed in English. It was produced in 1473 either in
Bruges or Ghent in the European continent. The book
by Raoul Lefèvre is a recuyell (compilation) of stories
about the Trojan War, originally written in French.
Caxton himself translated the book.

British Library - Learning English Timeline

When A Letter Reaches the Computer11111
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This page contains text and images. How can we input
the text into the computer? Which hardware can we make use
of for this purpose?

As years passed, stone moulds which were used for
printing gave way to metal moulds. Later these moulds
also went out of use. Nowadays, the contents of a book
are typed and arranged (layout) with the help of
computers.

Have a look at the extract from a page of your
English Reader given below (Pic. 1.1). How would this
have been prepared? Definitely, with the help of a
computer. This is exactly what we are going to learn in
this chapter - how to prepare a page like this with the
help of a computer.

Text entry

Pic. 1.1 Tagore’s poem - Taj Mahal

      Typewriter

Have you ever seen a
machine like this? This is
a typewriter which was
used in earlier days for
typing. As computer
became popular these
machines are no longer
in use.
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Pic.1.2 English keyboard layout

It is the keyboard which is familiar to us that comes to
our help. The manner in which the letters of the alaphabet
are arranged in a keyboard is called ‘Keyboard Layout’.
Look at Pic.1.2 and examine the layout of an English
keyboard.

Have you noticed a mark on the keys ‘F’ and ‘J’ on
the keyboard (see Pic. 1.2)? We must position our
pointer finger of both the hands on these keys and then
the other fingers on the subsequent keys accordingly.
Now, move your fingers to the top and bottom rows to
find out which keys can be typed using each finger.
You might have to stretch your fingers to type some
keys in the other rows.

You can see that you will have to use your pointer
finger and little finger of both hands to type more keys
arranged in all rows of the keyboard. Refer Pic 1.2 and
identify the keys to be typed using each finger.

Practice typing

To type quickly and accurately is a skill one has to
acquire through practice. There are various software
that help us to learn typing in a scientific way.
KTouch, Tux Typing, etc. are examples of typing
tutor software. Test your typing speed using the
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Pic.1.3 KTouch screen

Information in the form of letters
We have learned to type letters, numbers and

symbols using a keyboard. What are the occasions where
we need to type letters, words and sentences?

 To draft letters

 To prepare articles

 To prepare documents


.............................................................................................................

Here we want to type a poem in  a computer. What
must we do?

 Type the words in the poem. If there are mistakes
occured when we typed it, we have to correct them.

 If some words are found inappropriate, we will have
to replace them with some other words.

 If you have to replace a particular word or a name
with another in an article containing 500 pages, what
will you do?

 You may sometimes find sentences misplaced. How
will you place them correctly?

KTouch typing tutor installed in a computer. One
must be able to type at least 40 words (200 characters)
per minute without mistakes. Little finger not too

little!
How many letters are
there which are to be
typed using the right
hand little finger? List
them down. You can see
that your little finger is not
that little!



1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789

11Information & Communication Technology - VIII

When A Letter Reaches the Computer

 Headings and letters can be made attractive by
giving colours.


..................................................................................................


..................................................................................................


..................................................................................................

Likewise there are a number of things that we
have to do while using a computer. There are various
options in our computer that help us to do these
activities.

Word processor
There are numerous software which help us to

prepare or process the text that we input into a
computer in the way we wish to. See Table 1.1.

Text
The information given as
input to a computer in the
form of characters, is
technically known as text.
The characters like letters,
numbers and symbols that
we have already typed can
also be called text. The
major device used to input
text is a keyboard.

Table. 1.1 Software and their developers

Software Software developed by

LibreOffice Writer The Document Foundation

Microsoft Word Microsoft Corporation

Appache OpenOffice Writer Appache Software Foundation

Abi Word Abi Source Project

The software listed in the above table are
generally called word processors. Identify which  of
these software are there in your computer.

How can you open the software LibreOffice
Writer installed in your computer?

........................................................................................................................

Activity 1.1 - Let’s type a poem

Using the keyboard of your computer type the
lines given below in LibreOffice Writer.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

Information & Communication Technology-VIII12

When A Letter Reaches the Computer

Taj Mahal

Taj Mahal is considered as one of the seven wonders of the
world. It is a work of art that excels time and history. The
following lines are from Tagore’s poem ‘Shah Jahan’. In this
poem Tagore speaks of the immortal creation, the Taj Mahal
and the timeless appeal of that great monument.

You knew, Emperor of India, Shah Jahan,
That life, youth, wealth, renown
All float away down the stream of time.
Your only dream
Was to preserve forever your heart’s pain.
The harsh thunder of imperial power
Would fade into sleep
Like a sunset’s crimson splendour,
But it was your hope
That at least a single, eternally-heaved sigh would stay
To grieve the sky.
............................................................................................

............................................................................................

............................................................................................

............................................................................................

While typing these lines,  we leave a space after each word
and when we complete a sentence, don’t forget to give a full
stop mark and a space.

We know that when the text reaches the end of a line, it
automatically goes to the next line. To start a new paragraph,
press the Enter key. If we want to go to next line - not as a new
paragraph - without completing the previous line (it often
happens when we type poems), hold the Shift key and press
the Enter key.

Other input methods
There are many people around us who are not able to type using a keyboard.
Similarly, there are some who cannot read the text displayed on the computer
screen. Won’t they have the need to use computers? How is it possible for
them to to use a computer? There are various ways to help such people to
input text and read the matter displayed on the screen.
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Text from books
The matter from a book can either be identified and read or converted to a text
file in a computer using various software. Normally it is done in the following
way :
 Take an image of the page using scanner and save it in the computer.
 The next step is to identify the characters in the image and change them to a

text format, like the one we get while typing using a keyboard. There are
software which can do this work very well. They are called OCR (Optical
Character Recognition) software. LIOS available in our system is one such
software. It works based on the OCR software like CUNEIFORM and
TESSERACT.

 Software that converts handwritten words on the screen of our mobile phone,
into text is very common these days. This is also an example of a software
which identifies letter forms and converts them to text.

Such a file which contains the data so converted can be used as an ordinary
text file.

Text from speech
Identifying the words of our speech, converting them to text and feeding them
into a computer (Speech to text) is another method.

Such text input is done as follows :

Input our voice into the computer using a microphone.

Convert the audio data that has been input in the computer into a text with the
help of software. Sphynx, Julius, Simon, etc. are such speech recognition software
for English.  Find out if there are any such software for Malayalam.

Pic.1.4 Different input methods
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Pic.1.5 Desktop and Workspace

Text editing
It is natural that we make mistakes while typing.

How do we correct them? Should we do the correction
while typing itself?

 Notice the vertical blinking black line in the
software window that moves as we type. This is
called the cursor. Cursor denotes the position of
the text that we are typing. We can place the cursor
anywhere in the text by clicking the mouse on that
place (we can also use the arrow keys on the
keyboard).

 It is better to make the correction only typing the
whole matter. This saves more time.

 If we find mistakes after typing the matter, what
will we do? Place the cursor on the incorrect word.
Use the Backspace key to delete the letter on the
left of the cursor (before the cursor). To delete the
letter on the right of the cursor (after the cursor)
use the Delete key. Then, type the correct letter.

 A dictionary is included in the word processor
software. Each word we type in, is verified in this
dictionary. When a word which has not been
included in the dictionary is typed, it is marked
by underlining the word. Right click the mouse on
the underlined word. What do you see in the menu?

 Imagine that we have misspelt a word and we are
not sure the correct spelling. What will we do now?

 Right click the mouse on the word.

 ............................................................................

 How can you include a new word in the dictionary?

 .....................................................................................

 If the word is not in the dictionary and we don’t
want to add it, what will you do?

 ....................................................................................

While dealing with
more than one

window

Pic. 1.5 shows the ‘Desktop’
of a computer (Operating
system). The rectangular
regions seen on the right
hand bottom indicate
different workspaces.

Let’s open one window in
the first workspace. Examine
whether it is visible when
we switch over to the second
workspace. This is an
efficient system when we
have to deal simultaneously
with more than one window.
We can open different
software in each workspace,
if needed. We can also
transfer or share data
between windows that are
opened.
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Let’s copy from one file to another
At present we are on the first workspace. Now,

click on the second workspace and open the Home
folder. Here you can see School Resources folder in
which you can see a file ‘Taj’ in the Std VIII folder.
You have observed the poem that is typed in, haven’t
you? You may copy the required lines and paste it in
your page. How can we do it?

 Select the required lines: Place the cursor before
the first letter of the text to be copied. Then, click
and hold the left button of the mouse and move
the pointer to the last letter. This process is called
‘click and drag’.

 Copy the selected part : Click the shortcut tool 
you see in the tool bar or click on ‘Copy’ seen in
the ‘Edit’ menu.

 Now, let’s go back to the window that was left
open in the first workspace. Here, we can see the
file that was opened earlier. Now, paste the copied
text in the required position.

Did you notice ‘Paste’ in the ‘Edit’ menu when
you opened it for copying? Now, how can you paste
the copied text?

............................................................................................

............................................................................................

One can also see ‘Cut’ in the ‘Edit’ menu. What
happens if you ‘Cut’  and ‘Paste’ instead of ‘Copy’
and ‘Paste’? What difference do you notice?

............................................................................................

............................................................................................

Activity 1.2 - Let’s copy a file

From the given file ‘Taj’, copy the second
paragraph and paste it into your file. Write down in
your notebook the process you followed.

    Death by comma
Make sure to type the
symbols in appropriate
position. See what happens
otherwise.

 QWERTY
Keyboard

Examine a keyboard in
detail. We can see that the
letters are arranged in 3
rows. The first few letters
towards the left in the first
row is QWERTY. Therefore,
this keyboard layout is
called ‘QWERTY Layout’.
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Let’s save
Now, we have completed typing the poem. Let’s

store this before we proceed. We generally come across
instances where we have to reuse the work done
previously by us in a computer. For this, we have to store
such files. This process is called ‘saving’. How do we
save this page?

Now, let’s try to save the file that we were working
with. We can do this by clicking on the tool    in the
LibreOffice Writer window. We can see our folders listed
on the right side in the window that pops up (Refer
Pic.1.6).

Then, place the mouse pointer on the required folder
and ‘double click’ on it. Likewise, by double clicking on
the folder, you can open your class folder and other sub
folders.

Folders and sub folders
Each and every work we do in a computer is saved as a file. Thus we will

have a number of files on the various works we have done. It is important to
arrange and save these files properly for future use. It can be done with the help
of ‘Folders’. We can create folder as follows:

 Place the mouse pointer on an empty space where you want to create a folder.

 Right click the mouse.

 From the menu select ‘New Folder’. We
will get a new folder on the place where
we clicked.

 Give appropriate name for this folder.

 Press ‘Enter Key’. Now, the folder is
ready.

In the same way one can also make sub folders (folders within a folder). This
helps us to categorise and save different files on the same topic. Refer Pic.1.6.
Create a folder, Students_Works_8 in the ‘Home’ folder. Inside this folder, create
a folder by the name of your class and a folder named ‘Docs’.
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To save a file:

First, decide where to save the file. Here, we
have to save the file in the sub folder ‘Docs’ in the
class folder in Students_Works_8 which is present
in the Home folder.

If we want to save on the Desktop, refer to Pic.1.6
and identify the icon to be clicked. (Desktop is where
we open all the software windows. It is not a good
practice to save files on the ‘Desktop’.)

What should be the name of the file to be saved?
We save files to use them at a later time. So, when
we name a file, it would be better to name it based
on the content. It would be better to name the file
using a single word. Shall we name this file
‘Taj_Mahal’?

Now, click on the ‘Save’ button.

Pic. 1.6 Window for saving a file

To save in the Desktop
open this.

This is the home folder. It
is the place to store the

files of the user.

Let’s beautify the characters
We have added all the lines in our page. Does

the computer understand that this is the heading?

For this, select the sentence. From the ‘Apply
Style’ tool in the tool box, choose ‘Heading1’. Observe
what changes happen to the heading.

..................................................................................................................
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Which tools are to be selected for the above
activities? Fill in the table below.

See how we can make the heading attractive?
Colour : Blue
Size : 30
Style : Bold
Font : Free Sans

See some of the tools that we can make use of in LibreOffice Writer.

Character What/How much?    How to do?

Colour           Blue

Size

Style

Font
Table 1.2 Character formatting

Paragraph formatting
We have already discussed how to split the

input text into different paragraphs. ‘Paragraph
Formatting’ helps us to:

A few English
fonts

Pic.1.7 LibreOffice Writer window
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 adjust the spacing between lines.
 adjust the spacing before and after a paragraph.
 give borders
 give background colours, designs etc. and make

our text attractive

Select the text in a paragraph. Then click on
‘Paragraph’ in the ‘Format’ menu.

The window that opens is given in the picture below.
You can give the required measurement in the boxes
you see here.

Pic.1.8 Paragraph formatting window

Refer to the picture and identify how to make the
changes required and fill in the columns in the  table
overleaf.
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Inserting pictures
Certain pictures are stored in the ‘Images’ folder in the

‘School Resources’ folder in the ‘Home’ of your computer.
Identify the pictures we need to use in our page. These pictures
can be included. Identify the tool used to insert images from
Pic.1.7. Click on this tool and find out what happens.

In the ‘Image’ folder of ‘School Resources’, there is a
picture named ‘TajAndTears.jpg’. How can we include this
picture in our page? Note down the steps.

 .........................................................................................................

 .........................................................................................................

 .........................................................................................................

 Select ‘TajAndTears.jpg’ and click ‘Open’.

Spacing above
each paragraph

Spacing below
each paragraph

Spacing between
lines

Table 1.3 Paragraph formatting

Single

   Activity     Required          How to make the change
     change

Border of the first
paragraph

Colour of the
border

The spacing of the
second paragraph
from the left
margin. This is
called indent.

Above &
Below

Blue

Select the first paragraph. Select ‘Borders’ in
Format - Paragraph window. Click on the  
icon to give a border to the paragraph.
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Using only the keyboard...
Some tasks can be done with the keyboard alone. We had earlier done the

Copy-Paste activity using the Edit menu. Let’s examine this once again.

 Select the text to be copied.

 Press and hold the Ctrl key and then press C to copy the text.

 Press and hold the Ctrl key and then press V to paste it.

Certain shortcuts are listed below. Complete the table below.

Activity Shortcut Activity     Shortcut

To copy

To cut

To paste the
matter that has
been cut or
copied

Table 1.4 Keyboard shortcuts

To save  Ctrl + C

To find a word in the
text

To make the selected
text bold.

Save again
The file that we are working with was saved earlier.

But we have made some changes in this file after saving
it. Will these changes automatically be saved in the
previous file?

No, we have to save it again. But what happens when
we click  ? Can we explain why the window that ask
where to save the file and with what name, doesn’t
appear?

If you have to save the same file within a different
name, what will you do?
 ................................................................................................................

Activity 1.3

Arrange the text in your file into paragraphs as in
Table 1.3. Include pictures and make the characters
attractive. Do not forget to save your file.
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Pic. 1.10 Gespeaker window

Out from the computer
The data taken out from a computer is called

‘output’. What would be the output of the text that
we have processed?

 While working with the text, we can see the
display on the monitor. Therefore, the monitor
is an output device.

 If we print this file, it is also an output. So, printer
is a device to output our data.

 The file that we have saved itself is an output. It
can be stored in devices like CD (Compact Disc),
or pendrive, or it can be sent as an email to
another person.

Activity 1.4 - Machine reading

Open the file that we have saved earlier. Copy
the text in it. Now, open the Gespeaker Software in
your computer (Application  Sound and Video
 Gespeaker). Paste the copied text in this window
and play it (Refer to Pic.1.10)

What form of output is received from the text
now?

........................................................................................

(Don’t forget to connect the speakers.)

Pic. 1.9 Printer

1. Some computer accessories are listed below. Which
of them are used for text input?

a) Keyboard

b) Speaker

c) Scanner

d) Camera

Let’s Evaluate
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1. Look at the nursery rhyme given below:

There was a tree

The cutest little tree you ever did see

The tree was on the valley

And green grass grew

And green grass grew

And green grass grew around.

There was a branch

The branch was on the tree

The cutest little tree you ever did see

The tree was on the valley

And green grass grew

And green grass grew

And green grass grew around.

2. To copy a portion of a text from the word processor, we usually select
the text by dragging the mouse from the beginning to the end of the text.
There are some other ways also to select a text. Place the cursor on the
text and do the activities given below and complete the table.

Follow-up activities

Can you guess what the next
line of the song would be?
Complete the poem by typing
necessary lines and copy-paste
the lines that are repeated.
Replace the word ‘green’ with the
word ‘blue’ in the  text using ‘Find
and Replace’.

2. Which of the following is true about the question:
What are workspaces used for?

a) To copy and paste a content from one file to another.

b) To cut and paste a text to another file.

c) To operate more than one window simultaneously.

d) To open various software at the same time.

3. When should we save a file we are working with?

a) After all the work with the file is over and when
we are about to close it.

b) As soon as we open the software and start our work
and then frequently save while working on it.
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3. There are different ways to copy a portion of the text in a page and paste
it elsewhere. You can use whichever method you are familiar with.

Now, select the text to be copied and click the right button of the mouse
on it. What are the steps to be followed? Write them down.

.............................................................................................................................

.............................................................................................................................

.............................................................................................................................

Activity Result

One mouse click          No change in the position of the cursor.

Double click the mouse

Click the mouse continuously
for three times
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By learning this unit, the learner will
be able to:
 prepare a write-up on the different ways of

making digital pictures.

 use Image Viewer to open a picture, resize it
and rotate it to the left and right.

 open pictures and photos using GIMP.

 take a duplicate copy of a picture in GIMP and
edit it by cropping the unnecessary parts.

 resize the picture using GIMP.

 add new canvas in GIMP and give background
colour. Type words and draw pictures in it.

 identify different file formats and classify them.

 export a picture prepared in GIMP into jpg,
png and tiff formats.

 prepare logos using GIMP.

 prepare screenshots.

The Wonderland of Pictures22222
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 Capture a photo using a digital camera and copy
it in the computer.

 Scan a picture from a book or a newspaper and
save it in your computer.

 Draw the picture in the computer.

Discuss and prepare a write-up on the various
methods of preparing digital pictures.

Certain pictures that can be used in the project
works are included in the ‘Image_editing’ folder of
‘School Resources’ for Std. VIII. Open the folder and
double click on one of the pictures. Did the picture
open? It will be opened in GNOME Image Viewer.
The complete name is ‘Eye of GNOME Image
Viewer’.

There are other image viewers in our computer.
gThumb, Shotwell Viewer etc. are some of them.
What will you do to see the next picture in the folder?
Do we need to close the window which is opened
now? Click on the ‘NEXT’ button. What other
facilities are available in this image viewer?

  Zoom and view the picture.

 Rotate the picture to the left and right.

   ...................................................................................

Haven’t you faced such a problem in your life
Have you ever felt the need to crop a photo of yours
and resize it with the help of a computer? This unit
will help you to solve such issues.

There is a project ‘Earth and Man’ in the unit ‘In
Search of Earth Secrets’ in your Social Science
textbook. You have to collect pictures, crop the
relevant parts and resize some of them and include
them while preparing the project in the computer.
How can you collect the required pictures? There are
several methods by which you can do it.

Activity 2.1 - Let’s get a picture

Hari happened to see an old family photo of his, while he was searching for a
book last day. The photo attracted him very much. He desired to crop his
childhood photo from it.

Where can
I get a picture

from?
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Look at the image opened in image viewer
(Pic.2.1). Have you noticed the figures in the status
bar below the picture. This is the size of the picture.
The measurement is 1628 x 1083 pixels. We have to
know the size of pictures while working with them
on computers.

Imagine that you have to cut the portion of  the
ploughed soil, bullocks and the plough man from
the picture, to use it in the project work. We have to
reduce the size of the picture too. How can we do
these activities? There are a good number of software
available in our computer to perform the above
mentioned tasks.

 GIMP

 Inkscape

 Tux Paint

 XPaint

 MyPaint

 Pencil

GIMP (GNU Image
Manipulation Program)
GIMP is a graphic editor
software used for editing
digital pictures and
photographs. This free
software was released in
1996. In the beginning it
was known as ‘General
Image Manipulation
Program’. Spencer
Kimball and Peter
Mattis, two research
scholars of California
University, started
GIMP as a research
project. It became a
part of GNU Project
in 1997 and was
renamed as ‘GNU Image
Manipulation Program’.

Pic. 2.1 - A picture opened in Image Viewer
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Pic. 2.2  - GIMP toolbox

These are some of such software. Open each of
them and see how it works.

Let’s perform the above said activities using
GIMP. First, open an image in GIMP.
Activity 2.2  - Let’s open a picture in GIMP

Click on ‘Open’ in the File menu and select
pictures to open them in GIMP. Or right click on the
picture. Then select ‘Open With’ and select ‘GIMP
Image Editor’ to open the image.

Now, let’s cut the parts of the picture we need
to use in the project. If we edit and save the picture
opened in GIMP, the original picture will be lost.
To avoid this let’s make a duplicate of the picture
and do the editing on it.
Activity 2.3 - Let’s prepare a duplicate image

Click on ‘Duplicate’ in the Image menu. Press
and hold ‘Ctrl’ and then press ‘D’ on the keyboard.
How can we identify the original picture from the
duplicate one? ‘Untitled’ will be displayed in the
title bar of the duplicate image. The changes made
in the duplicate image will not affect the original
image.
Activity 2.4 - Let’s edit an image

Let’s cut the part of the image we need. How
can we cut an image using the Crop Tool   ?
 Select the Crop Tool.
 Drag the mouse and mark the part we need to

cut.
 Press the ENTER key in the keyboard.

Did you get the part of the picture you need?

How can I open
pictures in

GIMP?

I don’t need
the full image.
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Activity 2.5 - Let’s resize an image

Facilities for resizing an image are available in
GIMP. To resize an image:

 Select Scale Image from Image menu.

 Enter the width and height in the columns
provided.

The height will be automatically adjusted
according to the width. (There is a Link which links
the height and the width.) Then click on the Scale
button. The size will be changed. How can we fix the
width and the height as we like? Click on the ‘Link’. It
becomes ‘Unlinked’. Now, you can arrange the width
and the height as you like.

Now, let’s save the image we have edited. Where
can it be saved? You have already made a folder in
your class folder in ‘Home’, haven’t you? Open it and
make another folder named ‘Images’ in it. Save this
image in it. Don’t forget to name the file.

Activity 2.6 - Let’s identify file formats

Let’s analyse the files saved in the folder. You
can see the extension .xcf after the file names you have
given. This is to indicate the type of the file. .xcf is the
indication of a file created in GIMP.

Activity 2.7  - Let’s export an image created in
GIMP

Open an image created in GIMP. Does it open in
Image Viewer like the other images? It’s opened in
GIMP itself. Why is it so? It’s only a project file. It can
be used only when it is converted into an image
format. ‘Export’ is used to change a file from one
format to another and save it. How can we export a
file?

 Select ‘Export’ from the File menu.

 Choose the location to save the file.

 Name the file.

 Click on ‘Select File Type’ and choose the file

How can I reduce the
size of this picture to

include it in the project
report?

Pic. 2.3 - Scale Image window

What is
 .xcf?
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You have already collected the pictures to be
included in the project report. Now, let’s prepare a cover
page for your project report. (Pic.2.4)

File Format

Image

Sound

Video

Spreadsheet

Word processor

     Project file

It may not be possible for us to complete all the editing of a picture at a stretch
using the GIMP software. We will have to open the file many times and make
necessary changes. Hence we keep them as Project File. We will export them
as picture, only when all the editing works on it are finished. When we edit
videos using video editing software, we keep them as Project Files. We can
continue editing only when the file is saved as Project File.

type, i.e., PNG image, JPEG image, TIFF image etc.
Now, you can see file extension after the file name.

 Click on the ‘Export’ button.

Analyse different types of files in your computer and
identify their file formats. There are different files in the
folder ‘Examples’ in ‘School Resources’ folder for Std. VIII.
Don’t you see file formats in each of these files? Open each
of them and identify the file types.

Identify the file formats given below and complete the
table. (Table 2.1)

File formats: jpg, mp3, png, wav, mp4, ods, odt, mpg, avi

Table  2.1  : File and format
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Pic. 2.4 - Cover page

Wilber
Wilber is the official
lucky symbol of GIMP.
It was prepared by
Tuomas Kuosmanen of
Finland in 1997.

Activity 2.8 - Let’s prepare a cover page

Open  GIMP first and make a new canvas. How
can we make a new canvas in GIMP? Do the following
activities.

 Click on the ‘New’ button in the ‘File’ menu.

 You will get a new window. Here you can select
the template you like. You can also set the canvas
by typing the required width and height. (We
prepared the project report in A4 format.
Therefore you can select A4 from the templates
given to prepare the cover page).

 Click on the OK button.
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Now, you have got a new canvas.  It’s time to give
background colour to it. As shown in the picture

(Pic.2.4) you can mix colours using Blend Tool  to
make the background more attractive and colourful.

Give colour to background

 Click on ‘Foreground & background colors’  

and select suitable colours from it.

 Select Blend Tool.

 Click on the canvas and drag.

You have got the background coloured. Now,
click on different points in the canvas and drag. What
changes can you see? You can see the background
coloured in different ways.

If you want to give a single colour to the

background, you can use ‘Bucket Fill’ tool .

Add a text

Text Tool   can be used to add text. Click on

the ‘Text tool’ button. Select a suitable font, font size
and font colour from the ‘Tool Options’ (Pic.2.5) menu.

Click on the canvas and type the text you need to

add. ‘Move Tool’  can be used to
arrange the typed text in its original position. Click on
the ‘Move Tool’ button and then on the typed text.
Then, move the mouse pointer. Did you feel any
difficulty to re-arrange the text? You can re-arrange the
text when the mouse pointer touches the text. A mark

 appears on it. If you click and drag the text, it can
be moved.Type the text and arrange it in proper
positions.

Draw a picture
Shall we draw a picture and add it in the cover

page (Pic.2.4) ‘Paintbrush Tool’  can be used for

GIMP was created by
Peter Mattis and
Spencer Kimball, the
American computer
programmers, as a
part of their research
project, when they
were students of the
University of California.

Peter Mattis

Spencer Kimball
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Pic. 2.5 Tool Options

this purpose. Select the suitable colour from
‘Foreground & background colors’  . Click on
the ‘Tool Options’ button and adjust the size of the
brush you need. Now, draw and add a picture and
make the cover page more beautiful.

Try to draw a straight line using the ‘Brush
Tool’. Don’t you feel a  little difficulty to do this?
Press the Shift key in the keyboard and try the
‘Brush Tool’ again. Is it easy now?

Activity 2.9 - Let’s make the heading more
attractive

Attractive titles can be prepared with the help
of ‘Logo’ in GIMP. Let’s see how a title can be
prepared.

 Click on File Create  Logos

 Select the Logos type you like.

 Type the title in the window and click on the
OK button (Pic.2.6).

Pic. 2.6 - Logo window

You have prepared an attractive title. Export this
title and convert it into a picture. You will learn how
to use logo in GIMP, in the higher classes.

I need an
attractive title for
my project report.
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Activity 2.10 - Let’s prepare a screenshot

Screenshot facility is used to save everything you
see on the screen, as a picture. How can we do this?

 Display on the screen the portions we need to
screenshot.

 Press the Print screen key (PrtSc) on the
keyboard.

Didn’t you get the screenshot? Now, save it. When
you are making a screenshot, you get the picture of
everything on the screen. If you want to get the screenshot
of a window opened exclusively, press Alt key and PrtSc
key together.

There are many other ways to prepare screenshots.
We can make screenshots using GIMP software also.
Using GIMP, it is easy to select a particular part of the
screen and take the screenshot.

 Open GIMP and select screenshot from ‘Create’ in
‘File’ menu.

 Give necessary details in the window opened
(Pic.2.7). (Whether to include the full screen or a
particular portion, a window or a particular portion
of a window, whether mouse pointer to be included,
time of capturing etc).

 Click on ‘Snap’ button.

 If you have to capture a particular portion of the
screen, click and drag to mark the part on the screen.

 Save the screenshot.

We can take screenshots using ‘Screenshot’ given in
Accessories menu and ‘Ksnapshot’ given in Graphics
menu. Take screen shots using these facilities and save
them.

Photo editing in mobile phones
Photo editing can be done in mobile phones also.
Different facilities to resize a photo, crop it and add text
to it are available in smart phones. Photo editing
softwares for smart phones are easily available today.

I’ve captured a scenery
using my camera. How

can I capture a picture
from my computer

screen?
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1. Which shortcut method is suitable for making the
duplicate of a picture opened in GIMP?

a) Ctrl +A

b) Ctrl + B

c) Ctrl + C

d) Ctrl + D

2. Eye of GNOME is an image viewer software. This
statement is:

a) False
b) True
c) Partially true

3. Which tool is used in GIMP to cut a part of a
picture?

a) Clone Tool

b) Move Tool

c) Crop Tool

d) Brush Tool

Pic. 2.7 - Screenshot window

Let’s Evaluate
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 1. Prepare a logo ‘Keep Your Footwear Outside’ in GIMP to paste it outside
the school computer lab and export it.

 2. Download a picture suitable for making a new year greeting card from
the internet, with the help of your teacher. Open the picture in GIMP
and crop the part you need. Resize and export it.

 3. Open the ‘Logo’ window in GIMP. Take its screenshot using KSnapshot
and save it.

Follow-up activities

File File Format

Picture file odp

Movie file mp3

Spreadsheet file jpg

Presentation file mp4

Audio file odt

Word Processor file ods

4. Match the following
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By learning this unit, the learner will
be able to:
 type Malayalam text with speed and accuracy.

 type Malayalam text as directed.

 type Hindi sentences.

 set the keyboard so as to input different
languages.

This is an extract from the Malayalam
dictionary ‘Shabdatharavaly’ (i_vZ-Xm-cm-h-

en) which was printed using metallic type
foundry. In olden days, printing books in
Malayalam was extremely difficult. There
are over 500 different combinations of
letters and symbols in Malayalam. Each of
them needed separate moulds. Arranging
these moulds to form the text was also not
an easy task. Imagine the difficulty if a
particular letter cluster appears many times
in a page! For example ‘°’. Think of the
trouble of including the word ‘[rjvS-Zypav\≥’
many times in a page! The task is not that
easy...!

Can You Type ‘A½’ in the Computer?33333
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‘aWn\mZw t]m¬ a[pcw \ΩpsS

ae\m´n≥ samgn aebmfw’’

These lines are composed by the famous poet
Sri O N V Kurup about the beauty of our language.
Can we type this in Malayalam and store it in our
computer? Some of us write stories or poems in
Malayalam. How is it possible to save them in
computers?

Let’s type in Malayalam
Normally, when we type using a keyboard, we

find English letters on the computer. How can we
change the keyboard layout to type Malayalam
letters? Refer to Pic.3.1.
 Click on the icon  that is

seen on the top right position on
the Desktop.

 Choose Malayalam from the
drop down menu.

Now, the keyboard is ready to
input Malayalam letters.

Open the word processor and
try to type the poem given above.
Can you do it easily and accurately? In order to type
fast, we should have a knowledge about the
Malayalam keyboard layout.

Inscript key layout

The order in which keys are arranged in a
keyboard is called keyboard layout. This is based on
the nature of the language and the flexibility of our
fingers. Pic.3.2 shows the ‘Inscript Key’ layout
developed by C-DAC, a central government agency
for typing various Indian languages.

Refer to the picture and observe the layout. What
are your findings?

The letters in Malayalam can broadly be classified
into two - Vowels (kzcm-£-c-ßƒ) and Consonants
(hyRvP-\m-£-c-ßƒ).

Pic. 3.1 Drop down menu of En icon
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The keys are arranged in such a manner that all the vowels (except ‘E’) are
typed using the left hand.

Most of the consonants are typed using the right hand.

Now, position your fingers correctly, as explained in the first unit and
complete the following table.

Pic. 3.2 Keyboard layout

Left Hand Right Hand

                Finger Normally

When Shift key is pressed

, I K

j J L
Right hand, Middle finger

Right hand, Ring finger

Right hand, Little finger

Right hand, Little finger extended

Right hand, Pointer finger
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Study the table given below and understand how combinations are made to
form different letters.

I #m  Im I #v I    °

X s#    sX I #v X    ‡

k t#m   tkm X #v b    Xy

\ ss#   ss\ a #v ]    º

Table 3.2 Combination of letters and symbols

Table 3.1 Fingering

k c l

i d M

Left hand, Middle finger

Left hand, Pointer finger

Left hand, Pointer finger extended

Left hand, Ring finger

Left hand, Little finger

Right hand, Pointer finger extended

Left hand, Litter finger extended

Thumb Space bar
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 Icn, NncpX, ]ScpI, tNcpI, tNmXn

 knXmc, anIhv, Ihe, ISph, \h\oXw

 Abe, Ba, Ce, CuSv, DSa, Dua, Hcpa, HmSpI

 HuX, IncoSw, ]pXpa, ]qhv, sImSn, tImgn, ssXamhv

 Im°, kz¥w, aq°pØn, N{μIm¥w, kuμcyw

 ]c-º-c, ]¶mbw, k©mcn, ]cn{iaw, BÀmZw

 ZpxJw, EXp, XrjvW, ]m‰, Fs‚, Xt‚Sw

Don’t forget to save the file. In which
language are you going to name the file?

Let’s now type some more words. For
example Ah≥, a¨]m{Xw etc.

To type the Symbols (Nn√-£-cw) in such

words we have to use a new key. This is the 
key used for this purpose.

For example,

≥    \   #vv    

¿     c  .....................

¬    e  .....................

¨   W  .....................

ƒ    f  .....................

Now, try to type the following words:

Ah≥, Ah¿, Ahƒ, a¨]mX, hn¬]{Xw

Activity 3.1 Lets type the words

Type the words give below. Make sure the
keyboard layout is Malayalam.

 Ic, XS, IS, ]X, XIc, ]cX

Pic. 3.3

Desktop Dictionary
Sometimes we find it
difficult to  understand the
meaning of some  words.
Usually in such circum-
stances, we seek the help
of a dictionary.

A dictionary named
Theeram is installed in your
computer which gives
meanings and usages of
words. It gives the  English
meaning of a Malayalam
word or the Malayalam
meaning of an English
word.

Pic. 3.2 Meaning of word Xocw
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What happens when you type the word klve?
How is it when you type tkm v̂‰vshb¿?

These are not Malayalam words. The letters
should not be combined as the combination letters
in Malayalam. To make these letters stand apart, we

make use of another key .

Thus,

klv     e  klv-e

tkm v̂‰v    shb¿  tkm v̂‰v-shb¿

The KTouch software that we used as English
typing tutor can be used for learning Malayalam
typing too. Open this software after changing the
keyboard layout to Malayalam. We get the lessons
to practise Malayalam typing. Seek the help of your
teacher to learn how we can include new lessons
for practice in this software.

Activity 3.2 Let’s type a poem

Type this poem in word processor.
Give the heading ‘Ip™-\p-dpºpw

Ipgn-bm\bpw’. Also insert a picture.
Select the lines of the poem and
change the font to ‘Raghu
Malayalam’.

We have already learnt how to
make changes in a text according
to our requirement. Set the page as
given here.

Other Desktop
Dictionaries

There are two other
dictionaries namely
‘Golden Dict’ and
‘Artha’ which helps us
to find the meanings &
usages of English
words.

‘Golden Dict’ is a
multilingual dictio-
nary.  It gives us the
English, Malayalam,
Hindi and Urdu mean-
ing of a word.

          ASSCII and Unicode

The letters and symbols that we input to a computer have to be converted to
a format that can be understood by the computer. This process is called
‘encoding’. Initially, this encoding could be done only for 256 characters
including the letters and some symbols.

Ip™-\p-dpºpw Ipgn-bm\bpw-

\bpw
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Pic. 3.4 Text in Gespeaker window

This encoding is called ASCII (American Standard Code for Information
Interchange).

Under such circumstances it was not possible to use the letters of other
languages like Malayalam. To overcome this difficulty, a solution was to convert
English letters to Malayalam using a software. ISM developed by C-DAC is one
such software. Though the font is visible as Malayalam letters, it is being encoded
as English letters. This was a drawback of this software. It was difficult to search
and find out a certain word from the input data.

As technology advanced, this problem was also solved. Unicode technique,
which helps us to encode more characters, came into use from 1996. Thus
Malayalam also found its place in the encoding technique. The letters and fonts
of Malayalam could thus directly be input into the computer. This was a drastic
change for Non-English languages.

Thus we can:

 Type Malayalam words in Malayalam font itself.

 Malayalam words can be used in the internet. Browse the web using
Malayalam words.

 Include information in data banks like Aadhar, Voters list etc. in Malayalam.
You can search and find names and other details from these data banks.

 If relevant software and font is available, the files created in one computer
can be opened and read on other computers, tablet PCs or even on mobile
phones.

 Texts can be read using machine. A text written in one language can be
translated to another language using software.

Reading text using machine
If we input a text in a language other than
English, we can hear it with the help of a
software, provided the speaker is connected.
How can we do this? Copy the poem typed
earlier and paste it in Gespeaker software.
Adjust the speed and pitch of the output and
click the ‘play’ button. One can listen to how
the software reads the text. Those who have
visual problems and are not able to read from
the monitor will surely find this software a
blessing.
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Malayalam fonts
The style of writing of each person is different

from that of another. The style of letters used in a
computer is called font. For example, some common
fonts of English alphabet are Liberation Serif,
Liberation Sans etc. Similarly there are various fonts
in Malayalam too. Find out the different Malayalam
fonts in your computer and complete the table.

Change the font of the text that we have typed
earlier. What differences do you notice when these
changes are made?

Input of other languages
Activity 3.3  Let’s add Hindi language

So far we have been discussing
Malayalam typing. As Malayalam
found its place in Unicode
technique, other Indian languages
also found their place in it. Now,
let’s examine how we can type in
Hindi.

We must make some
arrangements in our computer to
type Hindi in it. Refer to Pic.3.5.

The input languages available
in our computer is seen on the left
side. What should we do to include
Hindi? Complete Table 3.3. Pic. 3.5 Text entry settimg window

Malayalam character styles

Table 3.3 Different Malayalam font

Malayalam fonts

Rachana Raghu Malayalam

Chilanka Aruna

Meera
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    Activity                     Steps involved

Choose Text Entry settings Click on Text Entry settings from the menu
 on the right hand top of the Desktop.

Get the list of languages

Add Hindi Choose ‘Indian’ from the list.

Activity 3.4 Lets type Hindi letters

Change the keyboard layout to Hindi. Try to
type your name on the word processor. Are the keys
the same as the Malayalam letters. Prepare a similar
table as Table 3.1 on the use of fingers in Hindi layout.

You need some extra symbols in Hindi than in
Malayalam. Don’t forget to include these in the table.

Activity 3.5 Lets type Hindi text

The text given below is a portion from your Hindi
Reader. Type these lines using the font ‘Gargi’.

Table 3.3 Steps to add Hindi language

1. Which among the following keyboard layout
helps us to type Indian languages including
Malayalam?

a) Inscript b) ISM c) C-DAC
d) Rachana

2. The following table was prepared by Arun. He
wanted to categorise the fonts used to type
Malayalam & Hindi. He made certain mistakes
while preparing the table. Correct them.

Let’s Evaluate
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Malayalam Hindi
Gargi Anjali
Meera Samanata
Kalimathi Suruma

3. We have learnt how to add a new language to
our keyboard layout.  Suppose we no longer need
this language so added. How can we remove it?
Take the system settings window and write down
the steps to remove a language.

1. A diary written by Appu has been saved in the sub folder ‘Diary’ in the
folder ‘School Resources’ for 8th Standard in a jumbled order. Using
the cut and paste tools, arrange the sentences in the correct order.  Give
the heading ‘Appu’s Diary’.

2. Type the given poem and give a suitable heading.
Ip∂nSn®p \ncØp∂ b{¥ta

aÆp am¥nsbSp°p∂ ssIIfn¬

]¥pt]msem∂p In´nbm¬ \n¿ØtW,

H∂v Iq°n hnfn®dnbn°tW,

]≠p Rßƒ Ipgn®n´XmsWtSm

]¥p Imbv°pw acambv hf¿Øphm≥.

Try to find out the name of the poet with the help of the internet. For this,
copy the first line and paste it in the address bar of the search engine.



Follow-up activities
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By learning this unit, the learner will
be able to:
 recognise and write that the internet is the

network of networked computer.

 open and visit web pages using web address.

 make notes collecting required information
from web pages.

 distinguish and write the differences between
web browsers and search engines.

 collect images related to different subjects,
meanings of words etc. from the internet.

 make notes by acquiring knowledge about
E-commerce, Internet of Things (IoT) etc.

 make notes by acquiring knowledge about
cyber crimes, misuse of mobile phones etc.

44444
The Amazing World @ your

Fingertips
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Let’s know the mysteries of life in the little
chamber

You have studied the lesson Life’s Mysteries in
Little Chambers in your Basic Science textbook, haven’t
you? Do you know that M.J. Schleiden, who discovered
that the body of plants is made up of cells, was a
lawyer? Robert Brown who discovered the centre  of
cell, was a  doctor. There are cells which are known in
the name of Theodor Schwann who discovered that
the animal body is made up of cells. There are so many
interesting facts like this  in connection with the study
of cells. Don’t you feel it good to know more about
such facts?

What will we usually do for this? We seek the help
of our teachers. We read books from the library. Along
with these, we can rely on computers and internet to
collect information. Within seconds, the computer will
help you to gather a lot of information on any subject
with the help of internet. How does it work?

There are computer systems all over the world
which contain information about almost all subjects.
These computers work as inter-connected networks.
Those computers which are connected to these
networks can share the information stored in it. If we
connect the computers in our school to this network,
we can also access the information stored in them. But
don’t think that the information on the internet is fully
dependable and correct.

Computer networks

 We have computer networks connecting computers
at different locations around the world for various
kinds of service and mega computer networks
connecting different networks.

 This mega computer network spreading all over
the world and the facilities given by it is generally
called Internet.

Man gets a lot of services through the internet.
Among them are:

Pic.4.1 Internet diagram

History of Internet
The advanced research
project agency  under
American Defence
Department designed a
computer network
connecting computers at
four centres named
ARPANET (Advanced
Research Projects Agency
Network) for communi
cation purpose on 2nd

January 1969. This is the
beginning of the internet.
Later it is expanded as the
internet that we see now
by including many
institutions and countries
in this network. India
also joined in the global
network on August 15,
1995.

For more details: https://en.
wikipedia.org/wiki/Internet
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 Electronic learning which helps in education
(E-learning).

 The World Wide Web which helps in the
communication of information (WWW).

 The speedy mail service (E-mail).

 Video chat for face to face conversation.

 E-governance for getting governance and speedy
access to service from government.

 E-commerce for buying goods from all over the
world.

 Social networking sites help in the free cultivation
of friendship and sharing of opinions between
people all over the world.

Moreover, new facilities and techniques are
developed on internet day by day.

Now, let’s examine how information communication,
one of the major facilities on internet, is helpful to us.

Activity 4.1 Searching for information...

You are instructed to find out additional
information, images etc. about the cell from the internet
in the first chapter Life’s Mysteries in Little Chambers
in your Basic Science textbook (Pic 4.2). How can we
gather information from the internet? What are the
prerequisites needed for this?

Pic.4.2 Basic Science lesson

Internet cannot be
switched off...!

The working of the
internet which is world
wide, cannot be stopped
even for a day by
anybody.  This is
because, the internet is
not controlled from a
single centre.  Since the
internet is a network of
thousands of networks
spread all over the
world, even if one
network fails all the
others remain unaffected.

1. Our computer should be
connected to the internet.

2. We should know where the
information is stored in the
internet.

3. We need a browser
software which helps to
transfer information to our
computer.
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You may have noticed http://en.wikipedia.org/
wiki/Cell_biology given in your textbook. What does
it mean? This is the address of the web page where
the information about cell is stored. It is called the
website address (URL).

Find out more information about cells on internet
based on the points given below:

 Open Firefox web browser in your computer.

 Type http://en.wikipedia.org/wiki/Cell_biology
in the address bar of the Firefox window (where
we can see ‘Search’ or ‘Enter address’) and press
Enter key.

 Now, the information about cells included in
Wikipedia, the online encyclopedia, will be visible
on the monitor (Pic. 4.3).

Note down the required additional information
from this.

 Did you see ‘Languages’ on the panel on the left
side of Wikipedia? Go through the list of languages
given there. You can get information about cells
in all these languages.

Pic.4.3 Wikipedia page about cell

Web Browsers

Information from the
internet is displayed in
the form of web pages.
The softwares which
make this available are
called web browsers.
Firefox developed by
Mozilla project, Web
(epiphany) by GNOME
project, Chrome
(Chromium) by Google,
Internet Explorer by
Microsoft, Edge etc.
are examples of web
browsers.
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 Click on ‘Malayalam’ in the list of languages.
Now information about cells will appear in
Malayalam.

You  are now able to visit a website if you get its
web address of it.

We can see web addresses of various
institutions, newspapers, eminent persons etc. if we
go through periodicals, books etc. www.kerala.
gov.in is the website address that contains  official
information about Government of Kerala.

Collect various web addresses of popular
newspapers and institutions and visit their websites.

The first part of the names of the websites which
you visited is www. It is the abbreviated form of
World Wide Web.

Web pages and
website address

We can gather the
required information
from the internet only if
we know the name in
which it is stored in the
internet. The information
stored in the internet has
a specific address. It is
called website address.

The collection of web
pages which contains a
variety of information
which are mutually
linked is called websites.

Website address is also
called URL (Uniform
Resource Locator).

Web portal
There are websites which
act as ways to enter
various websites related
to a particular subject.
These types of sites are
called web portals.
www.kerala.gov.in is a
portal through which we
can enter different sites of
the Government of
Kerala.

World Wide Web
 World Wide Web is an important

service which enables information
communication through the internet.

 World Wide Web is a collection of crores of data
stored in computers all around the world.

 In World Wide Web, crores of data,
which are useful or not useful, are stored in web
pages as documents, images, videos, sounds etc.
which are mutually linked as well as not linked.

  Information from World Wide Web is available
on any computer connected to the internet.

Activity 4.2 Searching for images...

As instructed in your Basic Science textbook, we
have already found out some additional
information. But, what should we do if we need
different kinds of images of cells?

For this, we should know the addresses of
websites in which the images of cells are stored, as
we have discussed earlier.
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Some website addresses
for you...

You can visit these website
addresses:

www.education.kerala.gov.in

www.prd.kerala.gov.in

www.itschool.gov.in

http://india.gov.in

www.dct.kerala.gov.in

www.kstmuseum.com

Pic.4.4 Google search window

Some Search Engines
Goo -  Japan
rediff -  India
walla -  Israel

Accoona - China, America
Baidu - China
Biglobe - Japan

If the website address is not known, internet
provides some other facilities to find out the
information. These facilities are called Search
Engines.

These search engines help us to find out without
delay  exclusively the required information, pictures
etc.  from the huge information repository in World
Wide Web.

www.google.com, www.bing.com, www.duck
duckgo.com, www.yahoo.com etc. are some  of the
search engines available on the internet.

Based on the provided stages of activity, collect
different images of cells through search engines and
save in your folder.

 Open the web browser and type the address of a
search engine in the address bar (eg.
www.google.com).

 While opening Google search engine, a window
as shown in the Pic.4.4 will appear.
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Jimmy Wales

Larry Sanger

Ward Cunningham

 Type the word ‘cell’ (search word) in the search
box of the search engine window. (For getting
information from internet, it is enough to search
by giving a related search word).

  Now, the list of websites which contain the
information about cells will appear (Pic.4.5). To
get images of cells from this, click on Images seen
just below the search box.

Wikipedia
Wikipedia is an online encyclopedia. The name
Wikipedia is the mixed sound of the terms Wiki and
Encyclopedia. This is a joint venture for making a free
and complete encyclopedia in all languages. This
project works with the support of a voluntary
organisation, Wikimedia foundation. The content in the
Wikipedia will always be independent and free of cost.
The articles in the Wikipedia are prepared by service-
minded users all over the world who are working
voluntarily and collaboratively.

An American, named Ward Cunningham is the person
who initiated  the concept of Wiki and developed the
software. Using the software Wiki Wiki Web developed
by him in 1994, the website  www.c2.com is established
on 25th March 1995. Wiki means websites which give
freedom and facility to add, delete and modify any
information by any user. Since adding  information in
Wiki is very easy, Wiki became a fine means for
collaborative writing. The word Wiki is also used to
denote software which provide facility for making
notes, articles and other writings through a
collaborative effort.

Jimmy Wales and Larry Sanger started the project
Wikipedia on 15th January 2001. According to 2015
statistics, Wikipedia has editions in more than 280
languages. The English edition was produced under
their leadership. Wikipedia has editions in 20 Indian
languages including Malayalam.
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Tim Berners Lee

Sir Timothy John Tim
Berners Lee is the founder
of World Wide Web. Lee,
who started the method of
sharing information
through mutually linked
hypertext documents, put
forward the concept of
World Wide Web. He also
designed a web browser
that makes the web pages
visible. He is the director of
World Wide Web
Consortium (W3C) which
monitors the growth of the
web. Lee is also the founder
of World Wide Web
Foundation.

He was born on June 8,
1955 in Britain.

Pic.4.5 Google search list

Can all the images seen on internet be copied
and used?

Some websites give us the right to copy the
pictures, but some others do not. Certain others
give us the right on certain conditions. While we
collect pictures to be used after modification, we
should download only those which offer us
copyright.

Google also provides the facility to search
for pictures which do not have copyright.

Pic.4.6 Pictures of cells in different categories

 You have seen that pictures are displayed
on clicking on Images.

 You can see cells of different categories
(Human, Plant, Animal, etc.) in the first row
(Pic.4.6). You may click on the category in
which the required pictures are found.
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 Marc Andreessen

Marc Andreessen developed
a  graphical browser which
can handle images and
sound apart from characters
in the internet. He
developed the browser
Netscape navigator. He was
born in the year 1971 in Iowa
State in America.

 If you click on the search tools below the search
box, usage rights menu will appear as shown in
the Pic. 4.7.

 Select ‘Labelled for reuse with modification’ from
the list displayed while clicking ‘usage rights’.
Now, we can access pictures which are free to use
or modify.

 Click on the required picture and open it. Then
right click on the mouse and select ‘Save Image
As’ from the menu and save the picture for further
use.

Activity 4.3 Find the meanings of words

You might have come across various situations
where you had to refer to dictionaries to get the
meanings of words while learning lessons in English
and Hindi.

Various online dictionaries in different languages
are available at our fingertips in this era of information
communication technology. We shall familiarise
ourselves with some of the free language dictionaries.

 Visit the websites - http://ml.wiktionary.org,
www.olam.in. Note down the difficult words that
you come across in your English Reader find their
meanings and write them down.  Refer to other
dictionaries and check the meaning.

 These websites contain the meanings of not only
English words but also Malayalam words. This is
prepared using the information gathered from
various Malayalam dictionaries. It expands

Pic.4.7 Page in which usage rights are displayed

Copyright and
Copyleft

The information, pictures,
movies, sounds etc.
available on the internet
are prepared as a result of
the effort of different
people. There may be
some restrictions to use it
on our own. Some of them
have an exclusive right to
the person who developed
it based on the copyright
law. But some are free for
everyone to use. So while
we search and use
information from internet,
we must be aware whether
it is free to use or not. If it
is not free, we have to
procure permission from
the person or institution
concerned to use it.
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constantly with the joint effort of a number of
language loving volunteers across the state.

 Facilities for translating the meanings of words and
sentences to English and Indian languages like
Malayalam, Hindi, Tamil, Kannada, Telugu etc.
and to foreign languages are available on the
internet.

Can we use these online dictionaries without a
computer or an internet connection? There are solutions
to this too in this era of tablets and smart phones.
Offline versions of such dictionaries are now available
as mobile apps in mobile phones and tablets.

Shopping can be done sitting at home
We usually buy rice, vegetables and other things

by going to shops. Do you know that these things can
be bought without going to shops?

There are many commercial sites on the internet.
The trade using these commercial sites is called Online
Shopping. We can order the required goods by giving
our postal address in these shopping sites. We can pay
the cost of the goods by various methods. The goods
will be delivered to the given address by post/courier
service. Things are very  easy..., aren’t they? There are
websites which provide such facilities. Find out those
important sites with the help of your teacher.

While using the Internet...!
 While visiting websites, get the correct web address

and type it in the browser without mistakes.

 Sometimes, errors may occur while typing the web
address. You may be led to wrong websites or may
be cheated since there are people who utilise these
errors for such purposes.

 Sharing and uploading pornographic pictures and
videos are offences under various cyber laws. The
websites regularly visited by you can be observed
and information about your interest, character etc.
can be collected as part of enquiries by the
authorities.

 Vinton G Cerf

Vinton Cerf, who was the
director of ARPANET
project (the prototype of
the internet) is known as
the father of the internet.
He played an important
role in developing TCP/IP
(Transmission Control
P r o t o c o l / I n t e r n e t
Protocol) which is the basic
standard for transferring
information on the
internet. He was born at
New Haven in America in
the year 1943.
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  Mobile Apps for
anything and
everything....

In addition to finding the
meaning of words, we can use
smart phones for many other
day to day activities like
reading the  news, performing
banking transactions, finding
routes, reserving  tickets,
finding the bus and train
timings etc. Mobile
Applications (App) are now
available to help us. Apps
became popular because they
are easily available in mobile
phones as internet enabled
services.

Android Play Store of Google,
App Store of Apple, Windows
Phone Store of Microsoft etc.
help to install Apps easily.

While using Mobile Phones....

 Using mobile phone while driving will lead
to accidents. If you see someone using it
while driving, remind them of this danger.

 Taking photos and sharing them with an aim
to defame persons or institutions are
offences. Remember that taking photos
without one’s permission is also wrong.

 Messages which offer gifts, lottery etc. have
chances of cyber spoofing. Don’t react to such
messages.

 Creating false and fake messages which cause
defamation to others or stand against
national interest or generate rivalry among
caste/religion/class is an offence. Storing
such message in mobile phones, sharing
them etc. are also offences.

Cyber Crimes
Cyber world is a term that generallyrefers to the use of the modern information
communication devices like computer, internet, mobile phone etc. All activities
done using the information communication devices like mobile phones, computer,
internet, camera etc. which are against the law or which causes harm or defamation
to persons, institutions, technical facilities etc. are considered as  cyber crimes. You
will study more about this in the higher classes.

Internet of Things (IoT)
Are the electrical equipments at home switched off?  Is the valve of the gas cylinder
closed? Is the door closed? At times, you might be worried by such thoughts.
Sometimes, you would be relieved only when you check it going back home. Now,
electronic equipments at home will  observe all these things. They will take care of
these things which we have forgotten. Mobile apps and other facilities are available
for these purposes. In short, phones/tabs will become  multipurpose devices in the
near future. Internet of Things (IoT) means observing and controlling equipments
connected to the internet like this.
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(a) Mozilla Firefox

(b) Gimp

(c) Geogebra

(d) GCompris

3. The Internet is:

(a) Network of computers

(b) World Wide Web

(c) The mega computer network spread all over
the world and the facilities provided by it.

(d) Information communication through
computer networks.

4. The facility which helps to find out information,
pictures, etc. by searcing the internet is:

(a) World Wide Web

(b) Browser

(c) Search Engine

(d) Wikipedia

 5. The trade using the facilities on the internet is:

(a) E-mail (b) E-Governance

(c) E-Commerce (d) Chat

Let’s Evaluate
1. The facility that controls the information

repository on the interent is:

(a) E-Commerce (b) E-Governance

(c) World Wide Web (c) E-Mail

2. ........................... is a web browser.
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1. Prepare a note identifying the various services available through the
internet.

2. Examine the Malayalam dailies and collect their website addresses
and visit their internet editions.

3. Collect images of pyramids in Egypt from the internet and save them
in your folder.

4. Collect the details of various types of soil from the internet, copy them
to the word processor and save them.

5. Find out the Malayalam meanings of the new words in your English
and Hindi textbooks by using the online dictionaries in the respective
languages.

Follow-up activities

 6. The website which can be used free of cost for
collecting information:

(a) www.wikipedia.org

(b) www.bbc.com

(c) www.cnn.com

(d) www.rose.com



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

Information & Communication Technology-VIII60

My Own Computer Game

By learning this unit, the learner will be
able to:
 open ‘Scratch’ software and change the

background/stage

 add characters in ‘Scratch’ background/stage

 animate the characters in the background/stage

 create animations and games using ‘Scratch’
software

Don’t you like computer games? There are a
number of computer games in your computer which
are very helpful for learning and recreation. Are you
familiar with ‘Educational suite GCompris’, ‘Potato
Guy’ etc.? Do you know how these games are
prepared?

 Some of these games and animations are included
in the ‘School Resources’ folder in your computer. Try
to play these games with the help of your teacher. The
window of an  interesting game in this folder is given
in Pic 5.1. This game is prepared using the software
‘Scratch’ which is included in your computer.

My Own Computer Game55555
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What should we do to prepare a computer
game like this? You can see the following features in
this game.

 A car racing track is given on the background and
a car which can be moved along the track is
included.

 The car can be moved using the Arrow keys on
the keyboard.

 Instructions are given to stop the game when the
car moves out of the track.

You can do all these using ‘Scratch’ software.
Let’s do these activities in the given order.

Pic. 5.1 Car game screen

Scratch: ‘Scratch’ is a software used to create animations,
cartoons and games easily.
Stage: Stage is the background appearing when we open
the scratch window. The background will most often be
white. You can change the background colour as you
like.
Sprite: The characters on the background of a Scratch
window are known as Sprite. Usually a cat appears as a
sprite when the Scratch window is opened. The software
provides facilities to make alternations in sprite.

Hi! It’s a car
instead of

me...?
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Activity 5.1  Edit ‘Stage and ‘Sprite’

Open  ‘Scratch’ software and edit the ‘Sprite’ adding
a car in it. Include a car racing track as the background.
(You can select the picture of a car racing track and a car
from the ‘Images’ folder in the ‘School Resources’ of your
computer. You can also add pictures drawn using Gimp
Software)

Pic. 5.2 Scratch main window

I am Sprite. Let me run
through this white

background.

Script area Sprite list

Sprite buttons

Stage

Order of activity

 Open ‘Scratch’ software.

 To add new Sprite: When we open the ‘Scratch’
window, usually a cat appears as the Sprite.
Facilities to alter the Sprite and add new pictures
are provided in the ‘Scratch’ window. For this, you
can use the ‘New Sprite’ buttons given above the
Sprite List. (See Picture 5.2 and Table 5.1 for help).
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New Sprite

Paint new Sprite

Choose new Sprite from File

Get surprise Sprite

Use

To draw and import New Sprite

Include pictures from Costumes Gallery

Use random pictures as Sprite

Table 5.1 Usage of icons

Delete Sprite : To delete a Sprite, make a right click on
‘Sprite’ and select delete option.

To change the background/stage : White background
is usually seen when the  Scratch window is opened
(Pic 5.2). To change the background, click on ‘Stage’ in
the ‘Scratch’ window. Now, you can see the tab
‘Costumes’ in the ‘Script area’ changing to ‘Backgrounds’
(Pic 5.3). ‘Background1’ will appear in the ‘Script area’
when you click on the Background tab. Click on the Edit
button to change the background. ‘Paint Editor’ window
will appear (Pic 5.3) on the screen.

Pic. 5.3 Changes made in the Sprite window to change the background

Oh! Please
don’t delete

me!

Button to
change the

background

Existing white
background

Backgrounds tab

Import button

Paint Editor window

Stage
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 New background picture can be included using the
‘Import button’ in the ‘Paint Editor window’.

Open ‘Scratch’ software according to the
instructions given above and include the background
given in Pic. 5.1  (car racing track) and the Sprite (car).
Make a sub folder named ‘Program’ in your folder.
After completing the activity, save the file in the sub
folder.

Activity 2 Animate the ‘Sprite’

You have noticed a car racing track given as a
stage and a car as a sprite in Pic 5.1. After the
preparation of the stage and the sprite, let’s make the
car move using the keyboard.

You may make use of the ‘Block Pallet’ given in
the ‘Scratch’ to animate and move the ‘Sprite’. To make
the ‘Sprite’ move using the keyboard, use the ‘Motion’,
‘Control’ and ‘Sensing’ tabs in the ‘Block Pallet’ and
follow the instructions.

Extended Activity
Open ‘Scratch’ Software and include an aquarium
as the background/stage. Add fish as characters
in the background.

Pic. 5.4 Block pallet

Game Instructions (Block Pallet)

Programming instructions in the ‘Scratch’ Software are included in the ‘Block
Pallet’. They are given in the tabs: Motion, Control, Looks, Sensing, Sound,
Operators, Pen, Variables etc. (Pic 5.4). Pic 5.4 contains instructions in the Motion
tab. The common features of the instructions of each tab are given below.

Motion: To move the ‘Sprites’ in the ‘Scratch Stage’ in different ways.

Control: To control the movements of the ‘Sprites’. Use the instructions in this tab
to decide when and how long the Sprite should move.

Looks: The size, interaction, whether to hide or show the ‘Sprites’ etc. are arranged
in this tab.

Sensing: To control the movements of the ‘Sprites’ according to the instructions
given in the keyboard or the colour of the monitor.
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Sound: To control the  audio of the ‘Sprites’.

Operators: The instructions to solve mathematical problems and to compare them
are included in this tab.

Pen: To draw figures on the ‘Scratch’ screen.

Variables: To include variables in the project. For example, we have to include
variables to decide the score of the game.

The car in the ‘Scratch’ stage will move forward when
the ‘Up Arrow’ key is pressed. Press ‘Down Arrow’ key
to move the car backward, the ‘Right Arrow’ key to move
it to right and the ‘Left Arrow’ key to move left. To
perform these actions, arrange the instructions as given
below, in the Script Area .

To move the ‘Sprite’ forward using the ‘Up Arrow’ key,
arrange the necessary code segments in the Block Pallet,
as shown in Pic 5.5. All these code segments are available
in the various tabs in the Block Pallet. You can make use
of Table 5.2 for help.

Pic. 5.5  The instructions arranged in the window which help us to make the car moving, using
‘Up Arrow’ key

Don’t forget to drag
and drop each and every

code segment.
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You have prepared the instructions to make the ‘Sprite’
move forward using the ‘Up Arrow’ key as given in Pic.
5.5.  Now, click on the ‘Start’  button in the ‘Scratch’
window and play the game. You can also make the car move
to both sides and backwards. How can the codes be
prepared for these movements?

Table 5.2 Code segments and use

Script Segment Use

The car moves backwards when the ‘Down Arrow’
key is pressed.

The car turns left when the ‘Left Arrow’ key is pressed.

The car turns right when the ‘Right Arrow’ key is
pressed.

Table 5.3 Script segment and use

No. Code
segment

Group/
Type Use

1 Sensing

Motion

Control

To give instructions using keyboard (to
sense it)
To move the car 5 steps forward. To
change the value of the rounded part
using the letter ‘A’.

It is used to continue the activity till the
game ends.  In the given example, the
‘Sprite’ moves forward when the ‘Up
Arrow’ key is used till the game ends. See
how the third code segment is included in
part ‘A’.

Control

To activate a set of codes on certain
occasions. This code segment is used to
move the car forward when we use the ‘Up
Arrow’ key. For this, include first code
segment in part ‘A’ and the second code
segment in part ‘B’.

3

4

5 Control To start the game when we click on ‘Start
Button’ in the ‘Scratch’ window.

A

B
A

2

A
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 •

Pic. 5.6 The window having the instructions to move the car to all directions

Now, you have prepared the game as shown in Pic

5.6, haven’t you?  Let’s start the game using  button.
Then complete the Table 5.4.

Sl. No. Code Segment Use
To inform the program that the
Down Arrow key is pressed (If we
make changes in the marked part,
we will get the code segments 2, 3
and 4).

1

Sensing

2

3

4

Motion

To  move 5 steps backwards.

To turn the car 5 degree left.

5

6

Oh!
Now the car

can be
moved to all

sides.

Prepare the codes with the help of Table 5.3 and Pic
5.6.  Add them to the ‘Scratch’ file already prepared.

Group/
Type
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Extended activity
Open the ‘Scratch’ Software
and include an aquarium as
the stage/background.
Include fish as characters
on the stage and make
them move using the keys
on the keyboard.

Activity 5.3 When the car moves out of the track

 You have prepared the code segments for
moving the car through the track with the help of the
arrow keys , haven’t you? Add a segment to end the
game, when the car moves out of the track. Bring the
car back to the starting point.

You can use the techniques like ‘Colour Sensing’,
‘Show‘, ‘Hide’ etc. in the ‘Sprite’ software. See the
instructions arranged in Pic 5.7. Add these instructions
to the project prepared earlier and activate it. You
can see that the game ends when the car runs out of
the track and goes back to the starting point.

To bring back  the car to the starting point,
where the game started.
To turn the car  towards the direction
where the game started.
To give one second pause between two
actions.

To hide the car temporarily.

To make the car visible again.

7

8

9

10

11

12

Table 5.4 Different code segments and their uses

Scratch Online
The animations, game and other resources prepared
using the ‘Scratch’ software can be uploaded.  You
can also view the resources shared by other people.
The website https://scratch.mit.edu and the online
group scratched.gse.harvard.edu will help you to
upload your files. This online group started in 2009
is known as ‘ScratchEd’. You will share the
animations and games you have prepared with the
help of these sites, won’t you?
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Colour Sensing
Now, you are familiar with the instructions given to help the program to identify
the pressings of the key.  The instructions to identify the colours on the screen
are also available in the Scratch software. These instructions are known as Colour
Sensing code Segments. The code segment to recognize a colour touching
another colour is shown in pic 5.7. This code can recognize when the colour of
the central part of the car touches the road outside the track. It is possible in the
following way

 Drag the Colour Sensing Instruction into the section needed in the game
code.

Pic. 5.7 An example of colour sensing segment

Colour sensing code
segment

 
A B

 First, click on the first (A) cell. Now, the mouse pointer will become the colour
picking tool. Then, click on the black central part of the car. You can see that
the ‘A’ cell has become black. Click on the ‘B’ cell and then click on the colour
of cell out of track. The game ends when the colour of ‘A’ cell touches the
colour of the ‘B’ cell. Play the game.
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Activity 5.4 Changing costumes

You have prepared the car game, haven’t you? Did
you notice that the running car and the static car are of the
same shape? Can the running car be made attractive by
making slight changes in its shape? For this, you have to
create or include a new car using the ‘Costumes’ tab. The
steps to create Costumes are given below.

 Select the ‘Sprite’ (car) and click on the ‘Costume’ tab.
The existing car will be visible as ‘Costume1’ under
the Costumes tab. (Pic 5.8)

 Press the Copy button below the ‘Costume1’.  You will
get a copy of ‘Costume1’ with the name ‘Costume2’.
(The car in Pic 5.8 is created in this manner.)

 Click on ‘Edit’ button to make changes in ‘Costume2’.
Now, ‘Paint Editor’ window appears. You can edit the
picture using the tools in the ‘Editor’. (See the three
grey bubbles in ‘Paint Editor’ in Pic. 5.8.) Then click
on ‘OK’ button.

Pic 5.8 Paint Editor window

Steps to include the changed ‘Sprite’ into the program are
given below.

Costume Tab

Copy button

Edit Button

Sprite

Paint Editor
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Exiting code segment Changed code segment

Pic. 5.5 Changing of a code segment

Now, play the game. You can see cars in different
shapes when in motion and stationary.

You can make more changes in the program of
this game. Scoring, using more than one car etc. are
some of the possibilities. Try it.

Not only games, but all the software you use in
your computer  are  developed with the help of
different  programming languages. Writer, Gimp, Calc
etc. are developed using different programming
languages. Don’t you want to prepare games and
animations like these? The car game we have prepared
can be a beginning.

1. Which of the given instructions can be used to
turn the car 30 degrees right?

a) _ b)

c) d)

Programming
language

All the softwares
including the ‘games’ in
the computer are created
with the help of different
programming languages.
Python, C++ etc. are
examples of programm-
ing languages. But these
languages are not easy to
use, because the
instructions should be
learnt byheart. If we can
make a program without
learning the instructions,
how easy it would it be!
This is also possible.
Visual programming
language helps us to do
this.  ‘Scratch’ is one such
programming language.

Let’s Evaluate

 The code segment used to make the car move
forward is shown in the first cell in Pic 5.5. You may
change this as in the second column and add it in
the existing program.

2. How can the background/stage of ‘Scratch’ software
be changed?
a) Select ‘Sprite’ and click on ‘Backgrounds’ tab

to change the stage.
b) Select ‘Stage’ and click on ‘Backgrounds’ tab

to change the stage.
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 When ‘Scratch’ software is opened you can see the cat
(Sprite). Prepare instructions to move the cat to all the
four directions.

 Include the pictures like Ballerina-a, Ballerina-b as
‘Costume Sprite’. You can get these pictures from the
‘People’ section of ‘Scratch Costumes’. Now, prepare
and activate the instructions to get ‘Ballerina-a‘ when
the key ‘A’ is pressed and ‘Ballerina-b’ when the key
‘B’ is pressed.

c) Select ‘Sprite’ and click on ‘Costumes’ tab to change the
stage.

d) Select ‘Stage’ and click on ‘Costumes’ tab to change the
stage.

3. Which one of the following tab includes instructions to move
the ‘Sprite’?
a)  Motion b) Control
c)  Sensing d) Looks

4. How can you change the ‘Sprite’ in ‘Scratch’ software?
a) Select ‘Sprite’ and  click on ‘Background’ tab
b) Select ‘Stage’ and click on ‘Background’ tab
c) Select ‘Sprite’ and click on ‘Costume’ tab.
d) Select ‘Stage’ and click on ‘Costume’ tab.

Extended activities

• Complete the table given below.
Sl.
No.

Code
Segment Use

1

2

3

4

Group/
Type
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My Own Computer Game

Scratch instructions Similar codes

If (Down arrow key is pressed)
          Backwards (5 steps)



1. Select pictures from ‘Costumes Gallery’ of ‘Scratch’ software. Using these
pictures, prepare an animation in which a bat flies in front of a house.

2. Prepare the animation in which an aeroplane flies in the sky.

3. Prepare the animation of a person dancing. Select and use pictures from
‘Sprite Gallery’ of ‘Scratch’ software.

4. Include another car in the car game that you have already prepared.
The new car should function when the keys ‘W, A, S, D’ are used.

Follow-up activities

 Some codes are there in the table given below.
Complete the table.
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By learning this unit, the learner will be
able to:
 consolidate and analyse data easily and effectively

with the help of software.

 identify and note down the rows, columns, cells and
cell addresses in LibreOffice Calc.

 tabulate data in LibreOffice Calc.

 add new rows and columns to a table created in
LibreOffice Calc.

 find the sum of the data using ‘Sum Function’.

 copy number series and formulas to an adjacent cell.

 arrange tables in ascending and descending
orders.

 prepare graphic presentations of data in LibreOffice
Calc.

Data Analysis Made Easy66666
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Have you understood the problem faced by Anu
and Amina? They are trying to consolidate and analyse
the questionnaires collected as part of a project. They
have a wide range of data with them, collected after
visiting a number of families. What are the activities they
have to do now? Notice the given procedure.

It is indeed a difficult task to classify, tabulate  and
analyse the data collected from more than one hundred
questionnaires and to reach conclusions. If we do it with
the helps of a computer, it reduces our work load and
makes the analysis easy. Spreadsheet softwares are
developed with a view to perform these kinds of
activities. Gnumeric, Calligra Sheets, Microsoft Excel,
OpenOffice.org Calc, LibreOffice Calc, etc. are examples
of spreadsheet software.

Consolidation
of Data

Analyse

Conclusion





While doing academic projects...
There are a lot of academic projects assigned in our textbooks. Academic projects
can be done as part of the lessons you have to study or based on a particular
social issue. Scientific and well planned data collection, consolidation, analysis
and making the right inferences are the features of project-based learning.
Findings of the study should be published as a report, presented and the follow-
up activities planned systematically. Different  softwares help us to do these
works easily and accurately. Here, Anu and Amina are doing an academic
project given in Std VIII Basic Science textbook in the unit titled ‘Let’s Regain
our Fields’. You can select relevant academic projects from your Science textbook
or from any other textbook.

Oh ! It went wrong this
time too! Collecting data
from houses was easier.

Let’s try once more.

Yes; How can we tabulate
the data from a hundred

questionnaires and analyse?
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Activity 6.1 - Let’s identify the cell address

Open the LibreOffice Calc in your computer and
observe it.

Don’t you see a lot of small rectangular boxes in rows
and columns? These boxes are called cells. Click the
mouse on each cell. Do you see that the cell you clicked
becomes more bright? This is called cell pointer. (Pic.
6.1). You can change the position of the cell pointer using
the arrow key in the keyboard also. We can type and add
information in the cell where the cell pointer is.

A cell is identified by its cell address. Cell
address is the combination of column header and row
header. Now, complete the table (Table 6.1) given
below.

.

Pic. 6.2 Visicalc

Pic. 6.3
Dan Briklin

Pic. 6.4
Bob Frankenstein

Name of
column

Name of
row

Cell
address

C 6 C6

12 H12

M 34

AJ AJ110

K65
Table 6.1 Cell address formation

Pic.6.1 Cell Pointer, Cell Address

Spreadsheet
Software

VisiCalc is the first
spreadsheet program
prepared for personal
computers. The first
edition was released in
1979. VisiCalc is the
acronym of ‘Visible
Calculator’. It was the
product of a joint effort by
Dan Briklin and Bob
Frankenstein. Spreadsheet
softwares like Multi Plan
and Super Calc were in use
at that time.
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What do you see just above the left end of the column
header? Isn’t it the address of the cell you have selected?
(Pic.6.1) Now, select different cells and identify their cell
addresses.

Activity 6.2 - Let’s add a new column and row

Amina and Anu have categorised the data collected
for their academic project. Now, they are consolidating
the data using LibreOffice Calc. The model of the table
they have prepared is given below (Pic. 6.5).

Pic.6.5 Model of the table to be prepared

Open the LibreOffice Calc in your computer and
prepare a table like this. Give a suitable name for the
file and save it in the sub folder Docs.

Not the serial
number.... It is the
name of the row

Everyone of us has one’s
own name. It helps
others to identify us.
Like that, each row has
its own name (Row
Header) by which the
row can be identified.
You have seen numbers
(1, 2, 3...) given on the
left side of the row.
Don’t mistake them as
serial numbers. They
are the names of the
rows. Now, try to find
out the names given for
columns in the column
header. Look at the
letters A, B, C, D... given
as the column header.
Numerals are used to
name the rows and
English letters are used
to name the columns.

Oh! What
shall
we

do now?

Oh... we have left out the
column to write the house

owner’s name.

How can we help Amina and Anu? They want to add
house owner’s name to the left of column D (House Name).
What should we do for this? Do the following activities in
the given order.
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 Click on any one of the cells in the column
‘House Name’.

 Select ‘Column’ from Insert menu (Pic.6.6)

Where did you add the new column? Now
give the heading ‘Name of the House Owner’ at
the top of the new column and add the names of
the house owners in the columns below that. Can
you guess where the new column will be added,
if the cell pointer is in the column ‘Measure of
Land Used’? Do it in the computer and make sure
that your assumption is correct. Now, write below
how to make new rows.

 .........................................................................

.........................................................................
Pic. 6.6 Adding a new column

Pic.6.8 Tools in Libreoffice Calc

Multiple ways to add
rows and columns

You can insert a new row in a spreadsheet. Right click
on the row header just below where you have to insert
the row. You will get a pop up menu (Pic. 6.7). You can
select suitable options from it. Try to add a column in
the same way. You can add a row or column by using

 buttons in the tool bar (Pic 6.8). How will you
delete an unwanted column or row? It can be done by a
right click on the header of the row or the column, we
want to delete. Try to delete a column or a row you
don’t need in the table. Find out the options available
on the tool bar.

Pic.6.7 Adding new row
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Fill Handle : to make any series easy....!

‘Fill Handle’ in the LibreOffice Calc can be used not only to add serial
number, but also to add series of months, weeks and days. Open a Calc
window and type ‘Sunday’ in a cell and try using ‘Fill Handle’ tool. You
can see the days from ‘Sunday’ to ‘Saturday’ in the cells below. Try month
and date just like this. How can we make a number series like 2, 4, 6...?
Type ‘2’ in the first cell and use the ‘Fill Handle’ tool. Type ‘2’ in the first
cell and ‘4’ in the second and select both of them and drag downwards
using the ‘Fill Handle’ tool. What changes do you notice? Next, make a
number series of the numbers below hundred which is divisible by 4.

Oh... I can’t
see the end
of this page.

It’s really
a ‘SPREAD’

Sheet

Add serial number

It will be better to add serial numbers in the first
column of the table. How can we do this? Add a new
column at the beginning of the table. Do you have to
type all the serial numbers in the column? Let’s  follow
the process given below and find out.

 Type ‘1’ in the first cell.

 Click on the cell and select it.

 Move the mouse pointer towards the right bottom
corner of the cell. What change can you observe?

 Have you noticed that the mouse pointer
changed into ‘+’ mark? This is called ‘Fill
Handle’. Fill handle helps you to copy data
or formulae to the adjacent cells (Data Fill).

 Now drag the pointer downwards. How
easy is it to add serial numbers!

Activity 6.3 - Let’s find the sum

Pic. 6.9 given overleaf is a page in the
project diary of Amina. How far has their work
progressed? What are the facts that they have
to find out as part of the analysis? Read the
diary entry carefully.
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Pic.6.9 A page from the project diary

You have read the page from Amina’s project diary, haven’t you? Now, expand
the table with the data she wants to collect.

.......................................................................................................................................................................................

......................................................................................................................................................................................
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How can we find out the answers to the above
questions from the table (Pic. 6.5) created in LibreOffice
Calc? First, let’s find out how much vegetables each family
produced.

To find the sum,

 Select the cell in which you have to get the sum total
of the quantity of vegetables produced by each
family. Isn’t the cell empty now?

 Click on the   ‘Sum’ tool in the toolbar (Pic.6.8).

 What do you see in the column (Pic.6.10) you
selected for getting ‘Sum’?

“=”, “SUM”, and the address of the first and last cells
of which you have to find the sum (parted by “:”)?
What do you mean by this? It means‘the cell should
have the sum of the data in the cells from F4 to J4’.

 Now, press the Enter Key. You will get the sum of
vegetables produced by one family.

How can we find out the sum of the
vegetables produced by the other families?

 Select the cell in which you got the sum.

 Find the sum of all the other cells using the ‘Fill
Handle’ on this cell.

 Double click on the “+” button instead of
dragging below. What happens?

When we add serial numbers, number series is
added in the nearby cells. But here, the formula for
finding the sum is added instead. How can we find out
itemwise sum of the vegetables produced? We have to
find the sum of the data given in rows instead of that in
columns. How can we find the production/acre of each
family?

Pic. 6.10 Sum Function

Functions in Calc
‘Sum’ is a function
(program) in LibreOffice
Calc. You can see a
number of functions like
this in LibreOffice Calc.
You will familiarise more
functions in the higher
classes.

Really a
Spreadsheet...!

Try to reach the last row
or column of the
spreadsheet. Oh...! How
many rows and
columns? Press the ‘Ctrl’
Key and ‘Down Arrow’
Key together. Don’t you
see the last row? See the
name of the last row.
Then Press the ‘Ctrl’ Key
and ‘Right Arrow’ Key
together. Your mouse
pointer will reach the
last column. See the
address of that cell.
Spreadsheets contain
lakhs of rows and
thousands of columns.
You can reach the first
cell by pressing the
‘Ctrl’ key and ‘HOME’
Key together.
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 We get the production/acre by dividing the total
production by the measurement of land used.

 Let’s write using the cell address as we have done to
find the sum. Suppose the total production is entered
in cell F7 and measurement of land in J7. Try to write
the ‘Function’ including the cell addresses of them.

     = .......  / .........

 Enter this function in the related cell and press the Enter
Key. You will get the production/acre.

You can see a lot of digits in certain cells. Select such
cells and use tools like  (Pic 6.8). Identify the use of
each tool and complete the table 6.2.

Do not Type the Cell Address, just Click!
Instead of typing in a function cell, you can use the following methods:

 Click on the function tool “=” (Pic.6.8) on the toolbar.
 Click on the cell in which the total production is given. You can see the

address of the cell, can’t you?
 Enter the symbol of division “/”.
 Click on the cell in which the measurement of land used is given.
 Press the Enter Key. Don’t you get the production/acre?

Find the production/acre in all cells using ‘Fill Handle’ tool.

Activity 6.4 - Let’s find out the Best Vegetable Producer

How can we find out the best vegetable producer from
the table? The best vegetable producer will be the person
who has produced the largest quantity per acre. It is difficult
to find out one person from a long list of agriculturists. It
will be easy, if we can arrange the list in descending order
in accordance with the amount of production. Arrange the
table in descending order using the steps given below. Pic.
6.11 may help you.

 Select the entire table.
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 Select ‘Sort’ from the Data menu.

 Select the column which is to be sorted in the ‘Sort
Key 1’. Here, it is production/acre column.

 Select from the option ‘Ascending/Descending’.

 Click ‘OK’.

Now, you can see the name of the best vegetable
producer on the top of the table. Note down the first
three best vegetable producers’ names and the
amount of vegetables they have produced. Don’t
forget to save the changes you have made in the file.

.........................................................................................................................

........................................................................................................................

........................................................................................................................

Activity 6.5 - Let’s beautify the table

Pic. 6.12 shows the beautified tables
prepared by Anu and Amina. See how
the title ‘Questionnaire Consolidation’
is given.

What are the features of the title given
here?

 This is the heading of the table.

 This is placed in the centre of the table in big
letters.

Pic. 6.11 Sorting

Table 6.2  Use of sorting tools

Tool Use

Pic. 6.12  Formatted and beautified table



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

Information & Communication Technology-VIII84

Data Analysis Made Easy

 In order to prepare a heading like this, we have to
merge the cells  in which we have to add the heading.
To merge cells, first of all select the cells to be merged.

Then click  Merge Tool from the Tool Bar (Pic.6.8).
Now, select the cells to be merged in the table.  You have
already learned to resize and colour the letters in
LibreOffice Writer, haven’t you? Prepare a catchy title
for your table too.

Cells should be formatted for
solving these problems. Do the following
activities to format the cells. Pic.6.13 may
help you.

 Select the cells to be formatted.

 Select ‘Cells’ in the ‘Format Menu’.

 Select ‘Alignment’ from the window
that opens.

 Check ‘Wrap text automatically’
(Pic.6.13).

 Select ‘Text Orientation’ and  ‘Text
Alignment’ and make necessary
changes.

 Click OK.

Pic. 6.13 Cell Formatting window

Heading of certain
columns are not

visible completely!!

If there was a
border for each cell, it
would have been more

beautiful.

 It is coloured.

 ..........................................................................................
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Pic. 6.14 Window to give border to cells

Now, you have given borders to all the selected
cells. Don’t forget to save the changes.

Activity 6.6 - Let’s include a chart

The project work of Amina and Anu is in its last
stage. They prepare to present their findings before an
audience. They have to complete the project report
which they are preparing in LibreOffice Writer. Then,
they have to prepare a multimedia presentation using
a presentation software.

Are the observations of Anu and
Amina correct? Isn’t it easier to
communicate with the help of graphs
and pictures than with big tables
containing a lot of figures? There are
options in LibreOffice Calc to create
beautiful graphs representing the given
data. You have already calculated the
itemwise production of vegetables.
How can we change them into a graph?
Select the cells containing the data
which is to be changed into the form of
a graph (Pic.6.15).

You might have noticed the border lines given to
the cells in Pic. 6.12. How can we give border lines to
the cells in the table we have prepared? Complete the
steps in the process given below and try it in Calc. Pic.
6.14 may help you to do this activity.

 Select the cells to which border is to be
given.

 Select ........... from Format menu.

 Select ............. from the window opened.

 Click on ‘Set Outer Border and All In-
ner Lines’ from ‘Line Arrangement’.

 Change Style, Width and Colour of the
line, etc. if necessary.

 Click OK.
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Pic.6.15 Adjusting the width of
the column

Adjusting the
Height of Rows and
Width of Columns

We come across situations
when we have to adjust
the height of rows and the
width of columns. Click on
the column header in
which the width is to be
changed. Bring the mouse
pointer to the nearby cell.
You can see the mouse
pointer changing into an
arrow mark. Now, you can
drag and adjust the size of
the column. (Pic. 6.15). You
can do this using the
‘Row/Column’ option in
the Format Menu.

It’s better to include a
picture or a graph instead
of a lot of digits, isn’t it?

Yes, it will
help the

readers to
understand the

facts easily

Pic. 6.16 Two parts in Spreadsheet
are selected together

How can we select two parts of a spreadsheet
together, as shown in Pic.6.16? If you select the second
part after selecting the first part, the part selected first
will be deselected. Now, press the ‘Ctrl. Key’ and select
the two parts. You can see that both the parts are
selected together.

After selecting the cells, click on  tool in the
toolbar (Pic 6.8). Do the following activities in the
window that opens in the order given.

1. Select Chart Type - ‘Column/‘Bar/Pie (Pic 6.17)

2. Click on ‘Next’ button in the windows, ‘Data Type’
and ‘Data Series’.

3. Provide a heading for the graph and names for X
and Y axis in Chart Elements (Pic.6.18).

4. Click on ‘Finish’ button.
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Pic.6.17 Chart Wizard - Chart Type window

Pic.6.18 Chart Wizard - Chart Element window

Analysis and
consolidation of data
were easy. Let’s say a

big thanks to
Thomas sir.

Not only to Thomas sir.
Thanks to LibreOffice

Calc also.

1. Complete the table given below :

Let’s Evaluate

Name of column Name of row Cell address

J 19
AA44

B B13
123 P123



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

Information & Communication Technology-VIII88

Data Analysis Made Easy

2. Prepare the calendar of January 2016 using the hints
given below:

 Use Fill Handle Tool.

 January 1, 2016 is Friday.

3. The following table gives the population of five districts
in Kerala, according to the Census 2011. Find out the
total population using LibreOffice Calc.

4. The following picture shows the menu Manu got when
he clicked on a tool in LibreOffice Calc. Study the
picture and write down your observations.

1) .................................................................................

2) .................................................................................

3) .................................................................................

4) .................................................................................

5. “Spreadsheet software makes academic projects easier.”
Substantiate your views.

Sl.
No. District Male Female Total

1 Kasaragode  626617   675983

2 Kannur 1184012  1341625

3 Wayanad  401314   415244

4 Kozhikode 1473028  1616515

5 Malappuram 1961014  2124942

Total
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Follow-up activities

1. Prepare a table in LibreOffice Calc of the height (in metres) and the
weight (in kilograms) of the students in your class. Calculate the
BMI (Body Mass Index) of all the students. Arrange the table as the
student with high BMI comes first. Beautify the table.

(Hint: BMI = Weight in Kg/Height in Metre)2 )

2. Collect the monthly expenditure on various items of ten families
living near your school. Consolidate the data in LibreOffice Calc.
Find out the total expenditure of each family and total expenditure
on each item. Prepare a pie diagram showing the expenditure on
each item. Beautify the table.
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Laboratories in your Computer

By learning this unit, the learner will be able to:
 do experiments and record the results with the help of scientific

simulations.

 find out the different states of substances with the help of PhET
software.

 explore and write the possibilities of simulation in self
learning.

 draw different geometrical shapes using the features of
GeoGebra software.

 identify the features and draw angles between lines, using
GeoGebra software.

 draw triangle and find out the measurements using GeoGebra.

 find out the facts behind the scientific names of elements and
other features with the help of Kalzium software.

 compare the features of different elements and prepare write-
ups using Kalzium.

 prepare models of molecules with the help of Ghemical
software.

 compare the structure of different molecules and prepare notes
using Ghemical.

Laboratories in your Computer77777
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The growth and development of science depend  on
experiments and observations. The basis of science is the
lessons that the primitive man got from his surroundings
and  experiences. Each finding and realisation  is the stepping
stone to the next phase int the growth of science. In this digital
age, we make use of computer technology to its maximum
in every walk of life.  Today, we have Virtual Labs which
help even highly complicated experiments in the field of
scientific research. Many softwares are also available today
to make our science lessons interesting. Let’s see some of
them.

Particles of substances and temperature

Have you ever thought of the elements with which our
universe is made of? What are the different varieties of
substances that we see around us? Substances have different
shapes, features, colours, smell and tastes. Our universe got
its wonderful shape and beauty from these substances.

  The air we breathe, the water we drink, the materials
we use to construct  houses, etc. have different features. All
these substances are made up of atoms. You have learned in
your science classes about the arrangement of atoms in these
substances. It is difficult to see and understand the features
of  atoms even with the help of a microscope. But nowadays
there are Simulation softwares which help us to understand
the atomic features of substances. PhET in Gnu/Linux is such

Can we do
experiments

using computers
too?
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a software. Let’s do some activities using this
software.

Activity 7.1 Let’s change the temperature of a
substance

Do you think that a change in the
temperature of a substance causes a change in
the nature of  atoms in it?  Let’s observe this
phenomena through PhET simulation.

PhET Simulation - Certain Hints

 Open ‘PhET simulation’ from ‘School
Resources’ in your computer.

 Click on ‘Play with Sims’ to find out the
activity in Physics to find out the nature of
atom (States of Matter).

 Click on ‘Simulation’.

 Find out the facilities in the main window
of States of Matter simulations with the
help of Pic.7.2 and do the experiments.

 Click on number ‘3’ to select a substance.

 Choose a suitable unit of temperature (0C’
or ‘K’) from the place where number ‘4’ is
marked (Pic.7.2).

Let’s change the temperature of a
substance. The simulation shows us how this
substance changes when the temperature is
changed. For this, click on the button where
‘1’ is marked in Pic.7.2. Then, the temperature
can be increased or decreased using the arrow
keys. When you reach the temperature needed
for the experiment, we can fix it permanently
by clicking the Esc button.

What did you understand from this simple

Pic. 7.1 PhET window

PhET is a collection of interactive
simulations which helps us to
teach and learn Science and
Mathematics. It is prepared by
the ‘Open Educative Resources’,
a project of the University of
Colorado Boulder in America.
The project was started by the
Nobel Prize Winner Carl
Wieman in 2002. PhET is the
abbrevation of Physics Education
Technology. Though it started
with simulations for Physics, it
was later spread to other
branches of science too.

PhET simulations are available
online.  PhET  Online  Simulation
is available in the website
‘phet.colorado.edu ‘.
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activity? In which state are the particles closely
packed -  solid, liquid or gas?  What difference does
it make in the nature of atoms, as the temperature
changes? Observe and make a note about it.

Activity 7.2 Let’s complete the table

Table (7.1) from your Science textbook is given
below. Complete the table with the help of PhET
software.

 1. To change the temperature
 2. To change the state of substances
 3. To select different substances
 4. To change the unit of temperature (oC  K )

Pic. 7.2 PhET - States of matter window

Simulation software
Experiments which cannot be carried out even in your school science lab can
be done using software. Science simulations are imitations of scientific
operations in the real world created in computers using software. Using this,
we can closely watch and study about complicated and dangerous scientific
phenomena, or those which happen in places we cannot reach. Most often these
simulations are created just for the purpose of observation study rather than
to get a copy of scientific facts. To observe how the same scientific phenomena
happen in different situations, we can change the value of the elements which
control that particular scientific phenomena. Such simulations are known as
interactive simulations. Stellerium (study of the sky and the stars and K stars)
is an example of a simulation software.
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Activity 7.3 Let’s complete the table using PhET software

Table 7.2 from your Science textbook is given below.
Complete it with the help of PhET Software.

When solid
changes to

liquid

When solid
changes to

gas

When gas
changes to

liquid

When
liquid changes

to gas
Movements of particles

The distance
between particles

The attraction
between particles

Energy of particles

Table 7.2 Complete the table using PhET software

1. Find out the state of the particles of water molecule
at 1200C with the help of PhET software and save a
screenshot of it.

2. Display the solid state of Oxygen with the help of
PhET and save a screenshot of it.

3. Display the state of water and Argon at 350K and
save a screenshot of it. Compare the three states.

4. Observe the movements of particles in solid, liquid
and gaseous states and prepare a note.

How does the nature of atoms change when they absorb heat?

 Energy of particles : ............................................

 Distance between the particles : ............................................

 Attraction between the particles : ............................................

 Movement of particles : ............................................

Table 7.1  Fill up with using PhET software

Let’s Evaluate
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1. Take PhET Online Simulation Lab from the internet
(phet.colorado.edu) and find out more activities from it.

2. Find out and activate other simulatins in PhET software related to the
lessons in your Science textbook.

Geometrical constructions

 You have drawn many shapes and observed their
features as  part of learning geometrical constructions,
haven’t you? How many angles are there between two
lines? There will be four angles between two
intersecting lines. To examine whether there is any
relation between these two angles, you have to make
more geometrical constructions in your notebook and
calculate their measurements to reach a conclusion. We
can do these activities with the help of software in our
computer.

Softwares like GeoGebra, Drawing Geometry, etc.
help us to draw geometrical constructions and to see
the changes in their measurements. It is included in the
education package in IT@ school GNU/Linux.

Geogebra is a software
which helps the study  of
Mathematics. This
software is available in
different operating
systems. We use
GeoGebra 4 which works
in GNU/Linux for doing
different classroom
activities. Marks Hoven,
who was a teacher in the
University of Salsburg,
Austria developed
GeoGebra in 2001 and it is
still being modified. This
is purely a Free Software.
Michael Borcherds, a
school teacher is another
person who played an
important role in
developing this software.

Marks Hoven

Follow up Activities
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Open the main window of GeoGebra and obsreve various
facilities available in it. (Pic 7.3)

There are many tools in Geogebra which help to construct
geometrical shapes. These tools are arranged in groups.
For example, tools for drawing points are included in
group ‘2’.

Pic. 7.3 The main window of GeoGebra

1. Tool to move

2. Tools related to points

3. Tools related to lines

4. Tools to draw verticals and
parallels

5. Tools to draw polygons

6. Tools to draw circles

7. Tools related to angles and
measurements

8. Tools to type texts

Table 7.3 Use of different tools in GeoGebra
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Activity 7.4 Let’s draw and measure angles between lines

Let’s see how we can draw and measure an angle
between two lines, with the help of GeoGebra software.
Select the tool ’Segment Between Two Lines’ from the third
group of tools and click on two points of the surface to
draw the line AB. Like this draw the line CD. (Pic 7.4)

Pic. 7.4 Intersect lines drawn in GeoGebra

We have to draw the joining point to mark the angles
between two lines. Now, select ‘Intersect Two Objects‘ tool
and click on the two lines.

Select ‘Angle’ tool. Click on and rotate clockwise on
the points which decide the angle. Click on and rotate
anticlockwise and find out which angle measurement is
received.

We can change  the  position of Vertex in the picture
using the ‘Move’ tool. Click on the ‘End points‘of the lines
and drag it, and observe how the measurements of angles
change.

Activity 7.5 Let’s draw a triangle

How do you draw triangles in your notebook? Usually
we draw triangles by joining three lines which are not in
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Let’s change the colour and
shape of the picture

Place the mouse at one point of the
picture drawn and click the right button.
Select ‘Object Properties’ from the menu
opened. You will get a window. There
are  facilities in this window to  change
the colour and shape of lines.

 kuIcyap-v.

Pic. 7.6 Object properties window

the same line, with the help of a ruler and
a pencil. In the same way, you can draw
triangles using GeoGebra. Besides this,
you can also draw triangles and polygons
easily, using the polygon tools (Group 5
in Pic. 7.3).

Open GeoGebra window and  choose
‘Polygon’ tool. Click on three points which
are not in the same direction and finish
clicking on the point you started with.
What are the measurements of the triangle
you have drawn? Choose ‘Distance or
Length’ tool (Group 7 in Pic. 7.3) from  the
angles and measurements tools and click
on  each side of the triangle. See the
measurement you get when you click
inside the triangle. Observe what happens
when you click inside the triangle using
the ‘Angle tool’ and the ‘Area Tool’ and
complete table 7.4.

Activity 7.6 Let’s prepare a heading

How can we give a heading to the
picture drawn in GeoGebra? Select ’ Insert
Text’(group 8 in  Pic 7.3) to type text and
then click on the canvas. Type the text
above the ‘Edit’ menu in the window
opened and click on the ‘OK’ button. To
make the heading attractive you can use
the facilities available in Properties
window.

Tools for measurement
Method of using tools Result

Click on the lines using ‘Distance or Length’ tool

Click inside the triangle using ‘Distance or Length’ tool

Click and drag clockwise in the vertex of the cones using ‘Angle’ tool

Click inside the triangle using ‘Angle’ tool

Click inside the triangle using ‘Area’ tool

Got the length of lines

Table 7.4 Tools for measurement

Pic. 7.5 Triangle drawn in GeoGebra
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Pic. 7.7 Text Edit Window

Pic. 7.8 Sixth group tools in
GeoGebra

Let’s save
To save your constructions
prepared in GeoGebra use
‘save’ in File menu. Give
the extension ‘ggb’ while
saving it.

You can also use ‘Regular Polygon’ tools to
draw triangles and polygons. When you mark any
two points in the canvas using this tool, there appears
a window demanding the numbers of sides of the
polygon. When you give the numbers of the polygon
in this window and click  ‘OK’, a polygon will
appear. Observe the features of the given polygon
and save it in your folder.

Activity 7.7 Let’s draw circles

In GeoGebra, there are many tools used to draw
circles. (Group 6 in Pic.7.3)

Let’s see them.

 1. A circle having one point as its centre and
passes through another point.

 2. A circle passing through three points.

 3. A circle with one point as its centre and another
as the radius.

To draw a circle with one point as its centre and
passing through another point, select ‘Circle with
Center through Point‘ tool and click on two different
points. Like this, use the other available tools and
practise drawing circles.
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1. Draw a pattern as shown in Pic. 7.9
with the help of Regular Polygon Tool.
(Hints: Midpoint tool helps us to find
out the midpoint of each side of a
polygon.

2. Draw a triangle using Polygon tool and
find out the circumference and surface
area of the triangle.

3. Draw the picture on Page 58 of your
Mathematics textbook in GeoGebra
(Pic. 7.10)

Hints: Draw a polygon with 8 sides using
‘Regular Polygon’ tool. Click on each sides
in anticlockwise and draw another polygon
with eight sides on each side.

4. Draw Pic. 7.11 using the small line tool.
Measure the outer angles, table them
and find out their sum. Repeat your
observation with different number of
sides.

Pic. 7.9

Pic. 7.10

Pic. 7.11

Follow-up activities

1. Draw two horizontal lines. Draw an vertical line across
them and measure all the angles formed.

2. Draw a Regular Polygon with five sides in GeoGebra
and give blue colour to it. Name it as ‘PENTAGON’.

3. Mark three points ‘A, B, C’ and draw a circle passing
through these points.  Join A, B, C and draw a triangle.
Give different colours to the circle and triangle.

4. Mark a point ‘P’ and draw a circle with 3 cm radius
and ‘P’ as its centre. Measure the length of the radius
using ‘Distance’ tool.

Let’s Evaluate
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Digital Periodic Table

You have already identified the features of particles
in different states of substances, with the help of PhEt
software. All substances on the earth are made of different
elements. Elements can be classified based on their features.
Periodic Table is a table in which elements are classified in
this way. See the periodic table given in your Science
Textbook. How many features of elements can you can trace
out from this table?

 Atomic Number

 Symbol

 Scientific Name

What will you do if you want to know more about
elements? More information can be gathered from the
internet or from books. There are many softwares which
can provide us with the information scattered in many
places. Most of them are interactive softwares which help
us to do many experiments and arrange the elements in
different ways.

Kalzium available in IT@SCHOOL GNU/ Linux is an
interactive periodic table which  provides facilities to study
and compare elements. (Pic. 7.12)

Let’s open the Kalzium software and see the facilities
available in it. In order to learn more about elements, they
are arranged in different ways in periodic tables. Select
these tables from the menu marked in red Pic.7.12. Among
these tables, which one is given in your textbook?
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Activity 7.8 Let’s find out the features of elements

Open Kalzium software and click on each element.
Facilities are available to know the different features of

the element you have selected. For example, let’s click
on Aluminium (Al) in the periodic table. What are the
details that appear? Observe the details of Aluminium
by clicking the tabs on the left side one by one. See the
details of Gold (Au), Iron (Fe), and Zinc (Zn) with the
help of Kalzium software and prepare a table as shown
in Pic. 7.6.

Activity 7.9 How elements got their names

In earlier times, the elements were named after
places, countries, names of scientists and planets.

The details about elements are given in Kalzium
software. Select an element and click on the
Miscellaneous tab on the left side of the window. You
can see the name of the person who discovered the
element, the year in which it was discovered and why it
is named so. The details of Zinc (Zn) are given in Pic.
7.14.

Complete Table 7.7 with the help of Kalzium
software.

Pic. 7.12 Main window of Kalzium

Periodic Table
Gperiodic, Periodic Table
of Elements etc. are other
softwares, like Kalzium
that provide details of
periodic tables. These
softwares include a lot of
information about each
element.



2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890
2345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890

103

Easy Way to Analyse Data

Information & Communication Technology-VIII
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789

103

Laboratories in your Computer

Information & Communication Technology-VIII

Pic. 7.13 Kalzium - Data Over View Window

  Element             Aluminium

  Symbol Al

  Melting Point 1808 K

  Boiling Point 3023 K

  Atomic Mass 55.845 u
Table 7.6 Features of the element - Aluminium

Who
discovered

Gold?

Pic.7.14  Kalzium - Miscellanous Window

Element

Table 7.7 Details of elements

Basis of name
Person who
discovered

Year of
discoverySymbols

Americium

Francium

Rubidium

Copper

Titanium

Chlorine

Am

Fr

Rb

Cu

Ti

Cl
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1. Find out the other softwares in IT@School GNU/Linux related to
periodic table of elements. Use them to identify their uses.

2. Find out the elements with the help of Kalzium software and tabulate
them chronologically.

Models of atoms

Water (H2O) is a compound familiar to us. Water is
a combination of Hydrogen and Oxygen atoms. Molecules
are made of minute atoms. Molecules  cannot be seen

Follow-up activities

1. Prepare the model of Chlorine atom using Kalzium
software. Take a screenshot and save it.

2. Symbols are used to represent elements. English
letters are used as symbols. Complete Table 7.8 with
the help of Kalzium software.

Element

Table 7.8

SymbolScientific name

Silver

Hydrogen

Tin

Antimony

Let’s Evaluate
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Pic. 7.15 Model of Methane
molecule

with our naked eyes. Have you ever thought about them?
Pic. 7.15 shows the model of a molecule of Methane (CH4)
which is contained in bio-gas.

As part of your classroom activities in Basic Science,
you might have made models of molecules using the
stick of coconut leaves and pearls. But with the help of
certain softwares, we can make models of molecules
easily. Ghemical, the software available in IT@ School
GNU/Linux helps us to make models of molecules and
observe them in different ways. Open ‘Ghemical’ and
observe the tools in it.

Pic. 7.16 Ghemical Window

Tool No.
(Pic. 7.16)

Table 7.9 Tool icons and their uses

UseTool Icon

Draw

Erase

Orbit XY

Set the current element

Set the current bond

1

2

3

4

5

To draw

To erase something

To turn the models three
dimensionally

To include atoms of elements

To select the chemical bond

Activity 7.10  Let’s make a model of molecule of water

Let’s make a model of the molecule of water using
Ghemical software. You know that a molecule of water
contains two Hydrogen atoms and one Oxygen atom.
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1. Prepare a model of Ammonia (NH3) molecule and
present it.

2. Make a model of Carbon dioxide (CO2) molecule
and save a screenshot of it.

Stellerium is a
simulation software
providing simulate
different sights of the
sky. We can the sky as
on any day or any time
in our computer with
the help of this software.
This is a very useful
software for sky
watchers.  We can find
out the constellations,
shapes, their names and
the distance between
them. There are details
of more than 6,00,000
stars in this software.

Let’s Evaluate

1. Which are the software available in IT@
School GNU/Linux to make the models of
molecules? Work using these softwares.

2. Collect models of different molecules from
the internet.



Follow-up activities

Pic. 7.17
Model of an molecule created using Ghemical

Let’s see how we can make a model of a water molecule
using Ghemical software.

 Open the Ghemical software.

 Click on the tool which is used to
include atoms and select Hydrogen
atom.

 Click on the canvas using Draw tool
and include two Hydrogen atoms.
Include Oxygen atom in the same
way.

 Click on the right button of the
mouse on the canvas. Click on
Render, Label Mode and Element
correspondingly and show the name of the element.

 Select ‘Chemical bond’ to combine atoms.

 Drag from one atom to another using Draw tool.

 Click on the right button of the mouse on the canvas
and click on Compute, Geometry Optimization
correspondingly to arrange the molecules.

 Select ‘Orbit XY’ tool to rotate the model of molecule.

 Rotate the molecule to various directions using the
mouse and observe it.
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Attractive Presentation88888
By learning this unit, the learner will be
able to:
 recognise and write about the scope of multimedia

presentation software.

 prepare a presentation storyboard.

 type content in a presentation software.

 save the presentation file in the folder after
improving the presentation using various
formatting techniques.

 insert a picture in the presentation and adjust its
dimension as required.

 move characters and slides using animation
techniques.

 present findings effectively with the help of a
presentation software.
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“Do you know me? I’m an overhead
projector. In earlier days, images
and texts were presented before an
audience using me . But after the
arrival of computers, my position is
in the attic of the school building.
I’m not worried about it. Because I
was replaced by a better one”.

Have you read the monologue of an overhead
projector? Overhead projector was an important
equipment we used earlier for presentation. Using this
projector, we could present images and texts prepared
in transparent sheets. We used to project the images and
texts on screens or walls using light rays. Haven’t you
seen the slot for keeping the sheet and the mirror for
reflection in the above picture? It was major limitation of
the overhead projector that motion pictures and certain
colours could not be projected. The development of
technology eliminated the need of overhead projector.
Today, we can effectively present our ideas before others
using pictures and motion pictures with the help of the
computer.

Did you understand what Anu and Amina were
discussing? They were discussing how they can
effectively present the findings of their project. You
already know that they were doing a project based on
the lesson Retreive Fields in their Basic Science textbook.

Can we help Anu and Amina? What details are to be
presented before the audience?

 Information related to project such as methodology,
limitations and scope of the study etc.

 Findings and conclusions.

 Pictures and other data collected as part of the project.

Then, don’t we
want to present

this?

Hoo... analysis and
preparing report is

almost over.
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 Audio and video clips of project activities, interviews,
discussions etc.

 Tables, charts, graphs.

 Relevant areas in the project report.


................................................................................................................


................................................................................................................

These details are now stored in computer and CD,
aren’t they? These are to be presented before the audience
at the right time with clarity. Imagine that we are using an
overhead projector for this. How many sheets will be
required for preparing these pictures and texts? But now,
these can be done easily using computers. The presentation
with sound effect and images is possible using the
multimedia presentation facility available in computers.
There are so many software to help this. These are known
as presentation softwares. The following are some popular
presentation softwares. (Table 8.1)

How can I present
this using sound and

image?

Software Developed by
LibreOffice Impress  The document foundation

Apache Software
foundation

Apache Open
office Impress

Kaligra Stage                  KDE
Key note                          Apple Inc.

Microsoft Power Point  Microsoft
Table  8.1  Different presentation softwares and developers.

Multimedia presentation is a slide show. What is slide?
It is similar to the transparent sheet used in overhead
projector. Presentation slide is a slide prepared in one page
that contains information which appears at a time. Instead
of slides prepared on sheets by drawing and writing, we
use the computer technology for preparing slides. That’s all.

What details are to be included in the presentation
prepared by Anu and Amina? Based on the hints and
points, prepare a note after discussion.
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 Texts, pictures, sounds etc. that are to be included in each slide.

 The background colour of each slide.

 The order and manner in which the slides are displayed.


.............................................................................................................

Complete your storyboard by observing the model of
presentation storyboard given overleaf. You can improve your
storyboard while preparing the presentation. Now, let’s try to
prepare a presentation on the basis the completed storyboard.
For this we have to use the LibreOffice Impress software.

Presentation Storyboard
Storyboard is a term we hear in connection with filmmaking, animation etc.
Before the shooting of a film so many preparations are needed. First, a story
for the film is to be identified. Then, a script will be formulated from the story.
Details such as camera position, dialogue of characters, movements, how and
where each scene is to be displayed etc. are to be decided well in advance
before the shooting begins. The next stage is preparing notes which include
minute details that are not there in the script. These notes are known as
storyboard. Storyboard can be prepared by writing or drawing. The details of
each and every scene are available in the storyboard. In the same way, before
a multimedia presentation is prepared, the details about how and where the
text, table, picture, sound, video etc. are to be displayed should be decided in
advance.  The outline prepared in this way before making a presentation is
called presentation storyboard. While a film storyboard contains the details
which are to appear in each scene, a presentation storyboard contains the details
to be included in each slide. It should be a note which contains all in details
about the colour, type, form, size of the font, background colour, movement of
letters, how and where pictures are to appear etc.  It should also include all the
changes to be made in a multimedia presentation.

LibreOffice
LibreOffice is a package which includes softwares like Word processor which is
used to prepare letters, notices etc.; Spreadsheet which is used to analyse infor-
mation; Presentation software used for presentation; Base used to handle data;
Draw used to handle pictures etc. LibreOffice editions are  now available for all
important operating systems. This is developed by The Document Foundation.
The main aim of LibreOffice is to create a non commercial office package
supported by ODF (Open Document Format). The name LibreOffice is created
by joining the word libre which  means freedom and the word office.
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Activity 8.1 - Typing Content

To type content, open LibreOffice window. Then try
to do the activities given below.

1. In the window opened, type the required content by
clicking the textboxes (Pic.8.1) named Click to add Title,
Click to add Text, etc.

2. Insert next slide. As seen in Pic.8.2, by clicking ‘Slide’
in insert menu a new slide can be included. Don’t forget
to select the required layout while inserting the new

Model Storyboard

Slide: 1

Subject- Land utilisation
and Vegetable
cultivation

Collage of various
vegetables

Font size : 44

Colour : Pink

Background : Sky blue

Animation : Fade in

Slide transition : .................

...........................................................

...........................................................

Slide : 2
Objectives of the Study
1. To find out the area of

available land.
2.To find out the area of

land used for agricul-
ture.

3.
..............................................

4.
..............................................

Font size : (Study
objectives : 44)

Others : 32

Colour : Red

Backround colour : Light
Yellow

Animation : Fade in

Slide Transition: ................

...........................................................

Slide : 3

Methodology
1.

...................................................

2.
..................................................

Cartoon by
a student

Font size (Method of
Study : 44)

Others : 32

Colour : Red

Background colour : Light
Yellow

Animation : Fade

Slide Transition : ...............

...........................................................
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Pic.8.1 Impress window

Pic.8.2 Inserting new slide

slide. Textbox can be created by clicking the
 icon seen at the top of the window.

3. Select the appropriate layout from the slide
layout (Pic.8.1) region.

The first stage of making a presentation is
typing the prepared content in the storyboard as
different slides. Then, save the presentation in the
Docs sub folder in your folder.

How to insert
a new slide!
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Pic.8.3 Page Setup window

Pic.8.4 Page Setting window

Activity 8.3 - Inserting a Picture

We know that it is very helpful for communication
if we present ideas along with pictures. To insert a
picture in the presentation, try to do the activities given
below.

A picture that we intend to be included can be
inserted either by clicking on  icon in the presentation
window (Pic.8.1) or by clicking Insert  Image.

The inserted picture can be modified in a suitable
manner for the presentation. For this, click on the
picture. Drag by holding the mouse on the small
squares that appear at the vertex of the picture. If the
size does not change as intended, drag the mouse by
pressing the Shift key.

Activity 8.2 - Beautifying the Presentation

The next stage is to beautify the presentation. This
process of beautification of the presentation can be
named formatting. You have studied the techniques
for beautifying characters and paragraphs in the first
unit, When Letters Reaches the Computer. In a
presentation, the characters in each box should be
selected and beautified in contrast to Word processor.

Giving Background Colour
For giving background colour to a slide,  try to

follow the steps given below:

 Click on ‘Page’ in Format menu.

 Select the Heading from Background in the Page
Setup window (Pic.8.3).

 Click on Colour at the Fill region in the window
that appears.

 Select appropriate colour and click OK button.

 We can give background colour to the slide as we
wish by clicking required location in the dialogue
box that appears.

Slide layout is the model of
pre-designed slides in a pre-
sentation software.
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Activity 8.4 - Watching the presentation

Now the presentation is prepared and is saved in
the folder. Let’s present it before an audience. Try to
start the slide show by clicking ‘Start from First Slide’ in
the Slide Show menu (Pic 8.5). Don’t the slides appear
one after the other? Is the computer monitor visible to
all the viewers? Don’t you require a projector to enlarge
the presentation? Connect the computer to a projector
with the help of your teacher.

Slide show can be activated by pressing the F5 key
on the top row of the keyboard.

Didn’t you watch the slide show? How was it? Did
you feel that it has to be improved? What is to be done
to make the presentation more effective? Note down.

 The texts, images etc. should appear in each slide as
desired by the presenter.

 The slides should appear in an attractive manner.


................................................................................................................


..................................................................................................................

Is computer
monitor sufficient
for presentation
before audience?

            Projectors

Projector is the equipment which projects images on a surface or screen with
the help of light rays. Normally, projectors reflect images with the help of light
that passes through a lens in it. But now projectors are available which directly
projects pictures with the help of laser.

Multimedia projectors are in use more nowadays. Slide projector as well as the
overhead projector specified earlier were its predecessors. The slide projector
which was in use from 1950 to around 2000 became completely obsolete after
the introduction of digital projector. They are known as LCD projector and
DLP projector based on the technology used such as LCD (Liquid Crystal
Display) and DLP (Digital Light Processing) respectively. Among these, LED
projectors use LED (Light Emitting Diode) technology for the source of light.
Movie projectors are used in cinema theatres.
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For this, let’s get familiar with more
techniques in the presentation software.

Activity 8.5 - Animating characters

The technique of animation can be used to
give motion to the characters in a presentation.
For this, follow the given instructions.

 Select the sentence/picture to be animated.

 Open the Custom Animation window by
clicking on  icon in the side bar (Pic. 8.6).

 Give appropriate animation by clicking on
  button in the window that appears.

Activity 8.6 - Animating slides

The manner in which slides appear during
the slide show makes the presentation attractive
and catchy. We can arrange the manner in which
slides should appear during the presentation. For
this follow the instructions given below.

 Click on Slide Transition in the Slide Show
menu.

Pic 8.5 Slide Show

Pic 8.6 Animation Window
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 Select the appropriate slide transition from the
window that appears on the sidebar (Pic.8.7).

This window also helps you to determine whether
the slide should appear on mouse click or automatically,
during the presentation. Hope you will make necessary
changes in the presentation after viewing it using slide
show.

1. As different from a Word processor, which of the
following characteristic did you find in a
Presentation software?

a) Characters can be given colour.

b) Page can be given colour.

c) Picture can be inserted.

d) Animation can be  given.

2. Storyboard is prepared while making a multimedia
presentation ____________

a) To decide the content of a slide in advance.

b) To save the presentation.

c) To create textbox.

d) To make the projector working.

3. Animation is given to a presentation __________

a) To show the slides in an attractive manner.

b) To give motion to characters and images.

c) To type the content.

d) To give colour to characters.

4. Slide Transition in a presentation is

a) To show the inserted picture in a slide as the
presenter likes.

Pic 8.7
Slide Transition window

Let’s Evaluate
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Follow-up activities

1. Prepare a presentation in connection with the project Soil and Human
Intervention in your Social Science textbook.

2. Prepare a presentation for an awareness class in connection with the
World AIDS Day.

3. Prepare a multimedia presentation to describe the milestones in the his-
tory of Cell Biology.

4. “ Journey gives not merely the experience of sight but a plenty of other
things to us.” - Prepare a presentation based on the activities given in
the lesson ‘Vazhiyathra’ in the Kerala Malayalam Reader including
the pictures of a journey you have made.

b) To give a background colour.

c) To decide the order of appearance of
slides.

d) To type the content.
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Hello.... Mic Testing...!!!

By learning this unit, the learner will be
able to:
 play audio files using various audio and media

players.

 connect microphone to computers and do necessary
configurations for recording an audio.

 do audio recording using computers.

 edit audio files to make it perfect.

 recognize the features and play different audio
formats.

 export various audio project files to different audio
formats using audio editing software.

 import more audio files to new tracks and mix
audio files with the help of audio editing software.

Hello... Mic Testing...!!!99999
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You have learned the poem Puthuvarsham
written by Smt. Vijayalakshmi given in Kerala
Malayalam Reader. Your teacher might have recited
the poem melodiously in the classroom. Have you
been fortunate to listen to any one else reciting it
melodiously in different tunes? Did you try to recite
the poem in a different manner?

In the era of computers and mobile
phones, if we record and save poems and
songs in these devices, we can enjoy them
over and over again whenever needed.

Activity 9.1 Listening and enjoying a
poem

Let us listem to the poem
puthuvarsham.mp3 included in the folder
audio_files in the menu School Resources
for 8th Standard in the IT@School GNU
Linux.

Double click on this audio file. In which software
is it opened? (Pic 9.1). Connect a speaker or head
phones, if you are using a desktop computer.

Find out whether there are any audio
players in your computer other than
Audacious, which you have used just
now. Check for any other audio player
software in which you can play these
audio files.

Arrangements of mic and sound
If we want to recite and record the

poem Puthuvarsham and then play it for
others, what steps do you follow?

“AΩ ]d™Xn\∏pdw as‰m∂p˛

an√m-Xncps∂mcmt∏mb Imew

amthen \mSphmWoSpw Imew, ]mSn˛

∏q\p≈nt∏mb s]mt∂mW°mew...”

Pic. 9.1 Audacious window

Pic. 9.2
Audacious Logo, Rhythm box Logo

Audio player of IT@School GNU Linux

GNOME Mplayer, SMPlayer, VLC
media player and Xine are the medeia
players in IT@School GNU/Linux
compatible for playing audio files.
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At first, we have to input our voice into the
computer. Which input device has to be used for this?

Yes. We should connect to a microphone and
make necessary arrangements.

     Connect the microphone to the audio input port of
the   computer. (Pic. 9.3). Click on Audio Applet

icon  on the top panel of the Desktop Screen and
select Sound Settings option to open Sound Setting
window. Now, drag the sliders in the Input and
Output tabs and make suitable settings to these. (Pic.
9.4).

Pic. 9.4 Sound Settings window

If we are using Laptops, do we need to
connect Microphone for voice recording?

           Phonograph and Gramaphone

Pic. 9.5
Gramophone
(Phonograph)

Pic.9.3 Microphone and its
connecting port

Audio Input Setting

Fifty to hundred years back, pre-recorded music
disks called Gramaphone records were used for
listening to music. Music was recorded creating
small grooves of different depths engraved on a
disc.  In order to play the music, a stylus was run
through the grooves.  This was the technology used
in its. Phonograph is considered the first device
used for recording and playing sound. Gradually,
Phonograph was developed into Phonograph
Cylinder and later refined to the Gramaphone.
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Dominic Massoni and
Roger Dannenberg
developed an open source
audio editor software in
the year 1999 as part of their
research project. Even
though it was a venture of
two persons, now almost a
hundred volunteer
developers including
twelve main developers
are working behind this
wonderful audio editing
software. Since Audacity is
distributed under GNU
GPL (GNU General Public
License), anyone can  use
and modify it freely.
Audacity versions are
available in all leading
operating systems like
Microsoft Windows, Mac
OS, GNU/Linux and you
can freely download its
versions.

Visit www.audacityteam.
org  for more details.

Pic. 9.6
Audacity logo

Pic. 9.7 Transport Tool Bar of Audacity

Audacity, Adobe Audition, Gold Wave, ACID
Pro are some of the audio mixing software widely
used nowadays. Of these, we use Audacity, a free
software. The provisions for audio recording and
audio editing are invariably found in all these audio
editing softwares. Sound recording, Sound editing
and File exporting can be done using Audacity.

Poem, in our voice!
Hope the microphone is connected to your

computer and the audio settings are done. Now, you
are ready to recite the poem.

Follow the given instructions to record the poem
using Audacity software.

Activity 9.2 - Recording a poem

 Open Audacity software.

 Activate Record button   in the Transport
Toolbar (Pic.9.7). (A wave form indicating the
sound recording is seen).

 After reciting the poem fully, press stop
button  to stop recording.

 Now let’s save the file using File  Save Project
to the folder Sounds under the folder of your class
in the /Home/Student_Works_8. (Create your
class folder and Sounds folder, if not created
before, while saving). Note that audio projects are
saved with the extension .aup.

Audacity, an open
source audio editor

Audio recording
We learned that to play a sound file, we should

have Audio Player or Media Player in the Operating
System. Similarly specific softwares are needed to
record a poem in the computer.
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 Use PLAY button  to play the recorded poem, use
STOP button  to stop playing. We use PAUSE button

 to pause playing and to resume playing press the
PAUSE button once more. You can use the SKIP TO
START button  to reach the beginning of the recorded
poem and SKIP TO END button   to reach the end of
the recorded poem.

Activity 9.3 Editing the poem

Suppose after pressing the Record button, a delay of
a few seconds occurred before the actual recitation of the
poem.

That non-recorded portion in the beginning and
corrupted area in between the recorded portions can be
removed. Don’t bother about the non-recorded portion or
the corrupted area of the recording or the unwanted noise
that has crept in.  All these can be edited and corrected
using the editing provisions in the Audacity software.

Open the audio project of the poem that we recorded
earlier using Audacity.

 The unwanted portion in the beginning and or at the
end should be removed. For this select the portion and
press Delete button of your keyboard.

You can also use Space
Bar of your keyboard to
PLAY and STOP audio
files alternatively.

Pic. 9.8 Editing window

Oh! I cough
in between.

Should I recite
once again?

 The corrupted part, non recorded part or unwanted noise
crept part, etc. found in between the recording can be
removed similarly.

 You can use Cut, Copy, Paste activities to rearrange the
position of the selected part of the recording. For
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example, suppose the first four lines of the poem
are repeated many times in the later portion.  In that
case, copy the first four lines and paste it to the
desired place in the audio track.

 If we think certain parts of the audio track are not
up to the mark, then rerecord those parts and copy-
paste them to the corresponding positions.

Caution

If you do not select a
region for editing, then

the editing will be
effected to the whole

audio file in the
Audacity window.

More effects
Hope you have removed all the corrupted

portions in your audio that is recorded.

What else is to be done next to make the audio
perfect? Do you feel the intensity of the audio is the
same everywhere? We can rectify any difference in
intensity in your recording.

Audio tracks

When we record a voice using Audacity, Audio
Track is the area  where the Wave Form, Vertical
Scale and Control Panel are shown. You can see
the stereo track in Pic.9.9. If you  record or import
an audio without selecting the track, such audio
files will be recorded or imported to a new
track. You can add any number of tracks and
use them one by one. Normally the upper
portion of the stereo track denotes left channel
and lower portion denotes right channel. In a
mono audio track, Wave Form and Vertical
Scale will be only a single track for both.

Pic. 9.9 Stereo audio track

A certain part of
the recording

has low volume.
Can we amplify

the sound of that
part alone?
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Activity 9.4 - Giving more effects

 Select the portion to be amplified.

 Choose Amplify option in Effect Menu.

 Adjust the New Peak Amplitude (dB) slider to
increase and decrease the volume intensity and set
it at the desired level (Pic. 9.10).

 Click OK to apply the settings.

Is OK button not active? (The changes you have
made in the New Peak Amplitude might have resulted
in high amplitude which is not desirable. Hence, the
OK button will not be active. In that case, to avoid
distortion of sound, a clipping has to be effected).
Activate clipping by putting a tick mark on Allow
Clipping. Now the OK button will be active, and click
to apply settings.

Likewise we can activate more effects on the audio
files using Audacity. Do you wish to include more
effects on your audio file?

Try different effects that you wish to include. If any
effect becomes uncomfortable or undesirable, you can
cancel the action using Undo option. Audacity permits
any number of Undo/Redo options.

Activity 9.5 Completing the table

After experimenting with different effects in the
Effect Menu, fill up the table given below.

Pic. 9.10 Amplify window

Don’t stun your ears !!!
The unit of sound is deci-
bel. Absolute silence is
considered as zero decibel.
Murmuring is of 30 decibel
and normal talk amounts
to 60 decibel. Hearing the
sound greater than 80 deci-
bels may damage your
hearing.

If you have the habit of
watching TV and playing
audio system with high
volume for long hours,
please avoid those unde-
sirable practices for the
safety of your ears.

Effect Usage

Fade in

Fade out

Change Pitch

Change Speed

.........................................

To increase the intensity of the selected audio part from
silence to the original intensity.
......................................................................................................................

......................................................................................................................

......................................................................................................................

To increase or decrease the pitch of the selected part.

Table 9.1 Effects and their uses
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Playing the poem in audio player
The poem saved with .aup extension can be

opened for editing in any computer in which
Audacity software is installed. But to play it using
Audio/Media players or to use it in webpages and
presentations, we have to convert the recorded audio
from Project Format to Audio File Format.

Now, we shall learn how to convert the Project
format to different Audio File format using Export
Audio option in Audacity.

Activity 9.6 Playing the poem

Exporting Audacity Project Format to other
Audio File Format.

 Select Export Audio in the File menu.

 An Export Audio window opens up. Type the file
name, select the folder where the file is to be saved
and the format in which the file is to be
exported (here let us select .mp3). Press save
button. (Pic.9.11)

Pic 9.11 Export Audio window

In the window that appears, give more details
about the file if needed.

Audio File Formats
Uncompressed audio

formats
This is the best file format
for saving original audio
files. Though such files
have bigger file size, its
quality of sound would be
high. Eg: .wav, .aiff

Lossless compressed
audio formats

In this file format, the files
are stored in a compressed
manner without losing any
information. Original
Compressed Format can be
regenerated from this
format. Eg: .flac, .alac
(Apple)

Lossy compressed audio
format

In this file format, data is
saved by omitting certain
information and that leads
to the decrease of  the file
size. At the same time the
quality of the sound is
compromised. Eg: .mp3,
.ogg, .amr
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Sing .... or not?

Now, you are familiar with different audio formats.

All the media players may not be able to
handle all the audio formats.

In such cases, one audio file format has to
be converted to another audio file format. We
will study the conversion in higher classes.

Activity 9.7 Identifying audio files

You can see different audio files in School
Resources in your computer. Identify the
audio formats seen there.

Play all these audio files in different
audio/media players and fill up the table
given here.

Combining introduction and
background music

Play your exported poem in any one of the audio
players. How is it?

Don’t you feel that an introduction to your poem
and also a background music will make the poem more
appealing?

Let’s do the audio mixing using Audacity.

For this, an introduction and a suitable background
music should be kept ready. This can be done as you
have exported your poem in mp3 format.

For the time being, you can use the introduction
and background music in the audio_files folder in
School Resources for 8th Standard.

Activity 9.8 Mixing audio files

 Open the poem in Audacity software.

 Import two files Narration .mp3 and bgm.mp3 from
the folder School resources for 8th standard --
Audio Files using the option File -- Import Audio.

 More
opportunities !

Resul Pookutty from
Kerala won the Oscar
Award for the best audio
mixing. The audio mixing
done in the film ‘Slumdog
Millionaire’ won him this
award. More and more
opportunities are waiting
for sound engineers in the
field of cinema, TV
channels, radio stations,
advertising, firms,
animation studios etc.
Dedication, hardwork,
patience, keen interest in
music are all essential for
one to become a successful
sound engineer.

Table  9.2 Compatible players for different
audio file formats

Extensions Compatible
Players

.wav

.ogg

.mp3

.amr

.................

.................

.................
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After importing, you can see these files in two separate
tracks (Pic. 9.12).

Pic. 9.12 Window consisting of Three tracks after importing

First we should hear the introduction. For this,
move the poem track to the right till the introduction
track ends.

You can use Time Shift Tool    to drag the audio
track. Here, drag the Time Shift Tool rightwards so that
the poem starts after the introduction track ends.

Pic.9.13 Track window after dragging
the first track rightwards

Now shall we play the
poem?

The poem, introduction
and background
music are played
together. Is it not?

While using these tools,
it is preferrable to use the
Stop button than using
Play-Pause button.

Selection: This tool is used for placing the cursor
anywhere in the track and also for selecting certain
portion of the track by click and drag.

Envelope: Using this tool, we can increase the
intensity of the sound track area where you feel the
intensity is low.

Pic.9.14 Tools Toolbar

Now, play the tracks again. You can hear the
introduction first and then the poem. But what about
background music? Some alterations are still to be made.

 We have to split the background music and place it
at different positions. For this, first place the cursor
to the position where the track has to be cut. Then
select  Edit - Clip Boundaries - Split. Now the track is
cut into two pieces.

After splitting, move the track to the desired
position using the Time Shift Tool.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

Information & Communication Technology-VIII128

Hello.... Mic Testing...!!!

Draw: To edit the nodes of the wave form.

Zoom: Left click on the wave form to zoom in, and right click on the
wave form to zoom out.

Time Shift: To move wave form leftwards and rightwards.

Multitool: For handling all the five tools.

 Now, split and join the poem track and background
music track appropriately.

See how the bits of background music is copy-
pasted to the areas wherever necessary.

Pic. 9.15 Window before exporting

 Play the tracks. If you find it pleasing and
satisfactory, save and export it.

The poem which is recorded, edited and mixed
by yourself is now ready. Play it to your friends
proudly.

1. The file ‘Puthuvarsham.aup’ created in Audacity
cannot be played in audio players and media play-
ers. Why?

2. Match the effects and their usages given in the table
below :

Amplify

Change pitch

Fade out

Starting with silence and to original intensity in an
ascending order.

To increase or decrease the existing level of intensity.

To ascend or descend the intensity of waveform.

Come on
everybody.

Listen to my
recitation.

Let’s Evaluate
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Hello.... Mic Testing...!!!

•

 •

 •

 •

 •

3. Two formats of the same song are Song.wav and
Song.mp3. Identify the two correct statements from
the four statements given below with respect to the
format Song.wav.

 1. It is a Lossy Compressed Audio Format.
 2. The file size is low compared to Song.mp3.
 3. It is a Compressed Audio Format.
 4. The file size is high compared to Song.mp3.

4. Match the tools and their usages in the table below:

Left click to Zoom In and Right Click to
Zoom Out.

To alter the intensity of the sound at a
particular point.

To move wave form right or left in a time
line.

To edit a wave form independently.

Follow-up activities

1. Open Audacity software and import any audio file from the folder
audio_files under the IT@School GNU Linux School Resources for 8th

Standard. Cut any four lines from that audio files and export to .mp3
format.

2. Open Audacity Software and import Narration.mp3 and
puthuvarsham.mp3 from the folder audio_files under the IT@School
GNU Linux/School Resources for 8th Standard. Place the the audio
Narration.mp3 before the audio puthuvarsham.mp3 and do the
necessary sound mixing. Then export the file in .wav format.

3. Narrate and record the story Ammamma written by P. Surendran in
your Malayalam Reader with expression and feelings. Add an
introduction audio text also. After completing the editing and mixing,
export it to .mp3 format.
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4. Recite and record the poem We are the World from your English Reader.
Include an introduction audio text also. After necessary editing and
mixing, export it to .wav format.

5. Recite and record the poem  in your Hindi Reader, Unit II.
Append an introduction audio text to the poem . After necessary editing
and mixing, export it to .ogg format.

6. Write and record a small drama of the radio_drama type with your
friends collaboratively. Do the editing and mixing . Save and Export as
.mp3 format.

7. You have studied the travelogue of a journalist describing his experience
in the minefield in your Social Science textbook. Assume that you are
preparing the article. Write the narration and record the article with the
help of Audacity Software. Export it as an audio file.
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By learning this unit the learner will be
able to:
 understand the changes in computers and

technology and prepare short notes.

 collect information about the major inventions
related to computers.

 categorise data as text, image, sound etc.

 identify input devices compatible for
processing different types of data.

 acquire an understanding of various application
softwares and prepare short notes.

 change the desktop interface settings.

 configure the system settings.

My Computer1010101010
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The above news indicates how man makes use of the
giant leaps in technology. Computer technology has grown
to great heights. What were the inventions that led man to
this modern era of technology. Let’s examine each stage of
technological growth in the world.

The history of computers
Examine Pic. 10.2 and discuss in detail the evolution

of the computer in each stage. Make short notes about these
stages.

Pic. 10.1
Charles Babbage

Charles Babbage
Charles Babbage was a mechanical engineer who
lived in England. During the first quarter of the
19th century, he designed a machine for
mathematical calculations. The Difference Engine,
was a machine to perform mathematical
calculations only. It was his first product. Soon
after, he designed another machine called
Analytical Engine which was operated by
instructions and was capable of doing  general
computations. This was the first computer in the
world. Therefore the world honoured him by
calling him the Father of Computers.

Collect more details by visiting the wikipedia. (en.wikipedia.org/wiki/
Charles_Babbage)

3D printing : Build a house in 3 hours!
How many days are  required to construct
a two storeyed building? Most probably
not less than six months. But in Shanxi
Province in China, a two storeyed house
was constructed in just 3 hours. Do you
think it is possible? But it is a fact. With the
help of 3D printing technology, each part
of the house like doors, windows, walls,
etc. were  printed in heavy 3D printers and
later joined using cranes. The raw materials
used for the construction of the house were recycled factory wastes!



1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789

133

My Computer

Information & Communication Technology-VIII

Eniac - First computer with size of one
big hall and low speed processing.

First commercial computer by IBM
(IBM 701)

Lisa - First personal
computer with Graphical
User Interface - created by

Apple.

World’s first
Personal Computer

 The Kenbak-1

Microsoft Windows
Operating System launched

GNU/Linux
operating system launched Smart Phone Era begins

Ericson R380

Rasberry Pi -
credit card sized

computer

Android- Linux
based free
operating

system. for
smart phones

Macbook_Pro
High end

Laptop from
Apple

Pic.10.2  Timeline of computers

Computer is a machine that can perfom many
tasks like receiving, storing and processing
information. What are the innovative changes in its
later development?
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Activity 10.1 Identifying evolution of computers

The table shown below depicts the evolution in the
shape of personal computers (Table.10.1). Collect more
information and try to fill up the left out columns.

 Has the structure suitable to be placed on a
table.

 System unit is the main component.

 Mouse and keyboard as input devices.

 Monitor as an output device.

System Characteristics

Table 10.1 Characteristics of computers

Data - Oh ! How many types?
In the early days, computers handled only text data.

But do you know how many types of data are handled by
modern computers? We have already learned about it in
previous units. Can you recall some of them?

 Text

 Sound


.............................................................................................................

Computers- so
big as a hall !
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We have learned how these data are entered into
a computer. We know that to input a data, a compatible
input device is to be connected to the computer. What
about retrieving data? Do you know how data is
retrieved? Here also, to retrieve the processed data we
should connect appropriate  devices. These devices are
called output devices.

Activity 10.2 Identifying and usage of various input/
output devices

Complete Table 10.2 by adding more information
to the blank spaces.

Table 10.2 Usage of various devices

Activity 10.3 Preparing shortnotes on input/output
devices

What are the main input and output devices used
in computers nowadays?  Prepare a short note on each
of them. Some of these devices in the list are:

Device Input/Output Usage

Keyboard

Mouse

Microphone

Camera

Scanner

Bar code reader

Joy stick

Monitor

Printer

Speaker

To select what is seen in the
screen

Input To enter text data
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Pic. 10.3
Douglas Engelbart

Right Button
Context Menu

(Shortcut Menu)

Left Button
Select, Drag,
Double click

Scroll Wheel
Move  and zoom

pages, etc.

Activity 10.4 Identifying the type of data for different input devices

See Table 10.3 and the images. Find out the data matching  each of the device
and complete the table.

 Keyboard

 Mouse

 Monior



Mouse
The prototype of the mouse that
we use today was developed in
the year 1960. Douglas
Engelbart, an American
Computer Engineer invented it.
The mouse helped the
computers a lot in making them
so popular among the common
people. First generation of the
mouse worked with the help of
a freely moving small metal
sphere kept at the bottom of the
mouse. Later, the working of the
mouse with the help of light rays
called optical mouse came into
existence.

Device

Image, Movies

  data

Table 10.3 Devices and types of data
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I see a keyboard in
the monitor. Oh! Is

monitor an input
device or an output

device?

Pic. 10.4 Touch screens

Computers and its peripherals operate with the
help of a pre-installed set of instructions. These
instructions are commonly called softwares.

Softwares - Let’s know more about them
Activity 10.5  Identifying the file type and required
software for different applications.

We know that a computer can do a lot of
activities with the help of specific softwares. The table
given below contains files, file types and their
respective softwares. Fill up the left out items and
complete the table.

Input or output?
Touch screen is used as an input device as well as
an output device simultaneously. Now, touch
screen technology is widely used in smart phones,
tablets, ATMs (Automated Teller Machines),
Laptops etc. Bent Stumpe, a Danish Electronic
Engineer, designed and developed touch screen
in the year 1972 and thereby started the era of touch
screen. Earlier, touch screens were controlled by
touching with a specially designed pen called
Stylus. Later, touch screens controlled by our
finger touch was developed and it monopolised
the technology market. Touch screens substitute
keyboard, mouse and monitor facilities.

For more details, visit en.wikipedia.org/
wiki/input/output, en.wikipedia.org/wiki/
touchscreen

File File Type Application Software
Leave application Text LibreOffice Writer
Marklist
Slide presentation
Drawing picture
Record voice

Table 10.4 File type and software for different applications
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Softwares and their functions are listed in the previous
table. Softwares are commonly known as Application
software.

To run these application softwares, the computer
should have some additional facilities. What are they?

Pic. 10.5 Computer Operating System

Pic. 10.6 Mobile Operating System

Mobiles also have Operating System

Mobile phones that we use also work
with the help of an operating system.

Andriod, Apple iOS, Symbian,
Blackberry OS are the some of the
mobile operating systems. Moreover,
now we have mobile versions of
Windows and Ubuntu as mobile
operating systems.

Andriod from Google is a Linux-
based free mobile operating system.
Linux based mobile operating system
was a turning point in the
multipurpose mobile phone scenario
and also caused depreciation in the
price of mobile phones. Today, e-
Commerce as well as m-Commerce
(online commerce using mobile phone
technology) has been flourished since
the advent of low cost multipurpose
mobile phones.

For more details visit:
en.wikipedia.org/wiki/Linux_for_
mobile_devices

en.wikipedia.org/wiki
Mobile_operating_system

Operating system

Operating System is the main
software that acts as an interface to
accomplish a user’s activity on
computer. GNU/Linux, Mac-OS,
Microsoft Windows, B.S.D, Unix are
some of the prominent operating
systems.

For more details visit:
e n . w i k i p e d i a . o r g / w i k i /
Operating_system
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 arrange the application softwares and be able to use
them conveniently when required.

 manage all input, output and storage devices.

 store the files created using the application software
in a schematic manner.

 communicate with the user computer and provide
him a conducive atmosphere to work on it.

Softwares giving such provisions are called
Operating systems.

Let’s learn and copy
Operating systems and Application softwares are

available under two categories: Free Software and
Proprietary Software.

The proprietary software from commercial
interested companies are meant for a single user. Users

Pic.10.7 Linus Torvalds &
Richard Stallman

Free Operating System
Even though computers were developed
earlier, the operating systems were
designed later. When personal
computers became popular, the
computer world started thinking of an
operating system which can be easily
managed by a user. In 1980, Apple
Corporation came with world’s first
Graphical User Interface Operating
system called Mac OS. Later Microsoft launched Windows operating system.

These operating systems can be used only with the permission of the
concerned companies and also restricted the freedom of the user in many
ways. This led to the idea of a free operating system. In 1992, Richard Matthew
Stallman of America collaborated with Linus Benedict Torvalds of Finland
developed and launched a free operating system called GNU/Linux. Now,
various versions of GNU/Linux are available for us. Department of
Education, Kerala State recognised the importance of the free software and
declared GNU/Linux as the official operating system. Many Government
departments in the state are now switching over to the free software.

At last, I am
free too !
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Beautification of the desktop
The computers in our school work with  GNU/

Linux operating system.

The desktop of this operating is seen in
Pic.10.8.

Do you wish to change the desktop
background?

Pic.10.8 IT@School GNU/Linux Desktop

The steps given below will help you to change the
desktop.

 Place the mouse pointer on the empty space of the
desktop and click the right button of the mouse.
Select Change Desktop Background option
(Pic. 10.9)

 Select the picture you like from Images displayed
under the wallpaper section of the window that
appears (Pic. 10.10).

are restricted from copying or manipulating the software.
But free software gives us the freedom to use the software
for any purpose, to edit the source code and incorporate
changes and to copy it.

We know that operating systems provide a conducive
platform for the application programs to work on it. Do
you know which operating system is used in your school?
What are the facilities provided in it? Let’s see one by one.

Android watches

Wearable computers are
also popular now. Latest
Android versions are
used in these devices.
The operating systems of
these devices are
designed to run
collaboratively with
Android versions after
the Android 4.3 (Jelly
Bean). Therefore the
operating system of such
devices is known as
Android wear.

Android watches, Android
spectacles, etc. are now
available in the
market.



1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789
1234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789

141

My Computer

Information & Communication Technology-VIII

Folders to store files
You are familiar with the desktop of your operating

system. Did you notice an important folder in the
desktop?

The folder named Home is the main folder where
the user’s files are stored. You have saved all the
activities done in the previous chapters in this folder.
Do you know where you saved your activity files?

Find the path of a file
 Open your folder and right click on any of the saved

files.

 Select Properties and carefully read the text shown
against Location in the window that appears.

You see the text as /Home/....... What does it
indicate? It indicates that your file is stored in the folder
named Home or in the sub folders created inside the

Pic. 10.10 Window for changing desktop settings

 Click on Add (+) sign (marked as 1 in the Pic. 10.10),
you can set more pictures as background.

 Click on the combo box button (marked as 2 in the
Pic. 10.10), you can change the theme.

Find out more options for the beautification of the
desktop? We will learn about more advanced options
in higher classes.

It’s time to
change the
wallpaper.

Pic. 10.9
Window for activating

Desktop settings
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Pic.10.11 Window that leads to
system settings

home folder of your computer. You will learn more
about file path in higher classes.

Be careful while saving a file
A file will be generated as a result of a work done

in the computer. Do not save this file carelessly with an
unintended name and also in an unintended location.
Always create a specific folder meant for it and save the
file in that folder. Do not forget to give an appropriate
file name while saving. This habit will help you to
remember and retrieve the file later when required. Do
you know where the files are stored if they are saved
without assigning proper name or exact location?
Normally, according to the type of file, the computer
will store such files in Home folder or in folders like
Documents, Pictures, etc. seen inside the Home folder.

Rename a folder
How do  you change the existing name of a folder?

Place the mouse pointer over the folder and click on
the right button of the mouse. Hope you got the option
for renaming the folder from the window that appears.
Now, change the folder’s name.

System settings
Did you type Malayalam in computer? In the

previous unit you have learned how to type Malayalam
or any other language in your computer.

If we want to type a new language, don’t we have
to set the specific keyboard layout? What are the settings
to be done?

Let’s verify.

Click on the Settings button in the top panel.

Select System Settings from the window that
appears (Pic.10.11).

Select Text Entry in the appeared window
(Pic.10.12).

Drones

An era of Unmanned
Aerial Vehicle (UAV) com-
monly known as Drones is
forthcoming. The things
you need will fly to your
doorstep, is not a distant
dream. The drone’s tech-
nology and its usage are far
developed beyond our
imagination. Days have
come where Unmanned
Aerial Vehicles are used in
war as well as in peace.
Drones are used legally for
wedding photo session,
Television and film shoot-
ing, Aerial surveillance etc.
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Pic.10.12 System Settings window
Pic.10.13 Text Entry Setting

widnow

Pic.10.14 Window for selecting
language

1. What are the milestones in the evolution of
computers from Eniac to Smart phones?

2. What are the common data handled in
computers?

3. Prepare a table correlating data like Text, Image,
Sound, etc., its compatible input/output devices
and the appropriate Application Software.

4. Examine the table and fill up left outs.

Activity Software Segment
To turn on a computer Operating system
To draw a picture in a computer Application software
To create a folder
To type a poem
To consolidate information
To change desktop background

From the coming window Click + button and
select the desired language and click Add button
(Pic.10.13, 10.14).

Let’s Evaluate
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Follow-up activities

1. Prepare a  presentation for a seminar using LibreOffice Impress on
the topic ‘Computer Evolution from Eniac to Smart Phones’.

2. Collect pictures and information about main Input and Output
devices of a computer. Then, prepare a presentation using LibreOffice
Impress with the data collected.

3. Conduct a debate on the topic ‘The Decreasing Difference between
Computer and Mobile phone’.

4. Create a folder named ICT at home  and also create three sub folders
named Office, Gimp, Program inside ICT folder.

5. Change your desktop background to a background depicting
flowers.

6. Open LibreOffice Writer and insert a table which should contain the
following information in Malayalam. Various data types, its
compatible Input/Output devices and its appropriate software.
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